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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for
warranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and
authorization to return the instrument or product. All repairs or replacements are made subject to factory
inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications
are made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold 
under their respective brand names or trade names. We, therefore, make no express or implied 
warranty as to such products. We shall use our best efforts to obtain from the manufacturer, in 
accordance with his customary practice, the repair or replacement of such of his products that may 
prove defective in workmanship or materials. Service charges made by such manufacturer are the 
responsibility of the ultimate purchaser. This states our entire liability in respect to such products, 
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, 
at the discretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed 
circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs 
(rotor) and stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for 
manufacturing defects. Such items which perform satisfactorily during the first 45 days after the 
date of shipment are assumed to be free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or
manufactures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
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1.  GENERAL INFORMATION

Organization of the Manual

This manual describes how to operate and maintain the DVVA II 4000 void volume analyzer; it 
is organized as follows:

Chapter 1 GENERAL INFORMATION

Provides a general description and specifications of the DVVA II analyzer.

Chapter 2 USER INTERFACE

Provides basic hardware and software interface.

Chapter 3 OPERATIONAL PROCEDURES

Provides step-by-step instructions on the operations for the DVVA II analyzer.

Chapter 4 SOFTWARE AND SETUP MODIFICATION

Provides instructions for installing software updates and for modifying 
analyzer setup configurations.

Chapter 5 FILE MENU

Provides a description of the commands on the File menu.

Chapter 6 UNIT MENU

Provides a description of the commands on the Unit menu.

Chapter 7 REPORTS MENU

Provides a description of the commands on the Reports menu.

Chapter 8 OPTIONS MENU

Provides a description of the commands on the Options menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE

Provides troubleshooting and maintenance information.
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Conventions

This manual uses the icons shown below to identify notes of importance, cautions, and warnings.

Chapter 10 ORDERING INFORMATION

Provides part numbers and ordering information for system components.

Appendix A ERROR MESSAGES

Lists the error messages that may be displayed by the software; includes 
cause(s) and action(s) for each.

Appendix B CALCULATIONS

Contains the calculations used by the software to produce reports.

Appendix C BULK DENSITY FOR CARBON BLACK

Provides the bulk density values for the SRB series reference materials.

Index INDEX

Provides quick access to a subject matter

Notes contain important information pertinent to the subject matter.

Warnings contain information that help you prevent actions that may cause personal 
injury.

Cautions contain information that help you prevent actions that may damage the 
analyzer.
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Equipment Description

The DVVA (Dynamic Void Volume Analyzer) II 4000 has been designed specifically for the car-
bon black industry. The DVVA II enables you to determine the occluded pore volume within the 
primary structure of carbon black using a compression-type method as opposed to the more 
lengthy oil-absorption methods. 

The operation of the DVVA II is simple. A quantity of carbon black is placed into the sample 
chamber. A piston travels down the chamber, compressing the carbon black against the lower 
piston. The software, in response to user-input, automatically controls the application of force so 
that high pressures are achieved with precision. As the piston begins to travel down the chamber 
and force begins to build, data points are taken at millisecond intervals; force, displacement, and 
time are automatically recorded.
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After analysis is complete, the upper piston drive reverses to release the force on the lower pis-
ton. The lower piston retracts, and then the operator swaps the lower piston tray with a waste 
disposal tray. The upper piston then advances downward until the carbon black pellet is expelled 
from the chamber and falls into the waste disposal drawer.

Safety interlocks are provided to prevent the analyzer from operating until the safety shield is 
lowered over the sample area. The safety shield and interlock system prevent personal exposure 
to moving parts on the analyzer. 

Specifications

The DVVA II 4000 has been tested to meet the specifications listed below. 

Characteristic Specification

Performance  

Linear displacement 
transducer:

Accuracy: 0.1% or better
Resolution: 0.003 cm (0.001 in.) or better
Repeatability: ± 0.1%
Reproducibility: ± 0.2%

Strain gage load cell 
transducer:

Accuracy: ± 0.25% or better
Resolution: ± 5 kg (10 lbs)
Repeatability: ± 0.25%
Reproducibility: ± 0.5%

For Tread or Carcass Carbon Blacks*: 

   Repeatability (r) Within-instrument repeatability (r):                  + 1 % of Void 
Void Volume at Geometric Mean Pressure       Volume Value
of 50 MPa, 75 MPa or 100 MPa

   Reproducibility (R) Between-instrument reproducibility (R),          + 2 % of Void 
normalized: Void Volume at Geometric            Volume Value
Mean Pressure of 50 MPa, 75 MPa, or 
100 MPa

*Based upon results obtained from multiple instruments for ASTM Committee D24 on Carbon 
Black SRB series 8, utilizing ASTM Practice D4483 for evaluating precision of test results.

Physical

Height: 190 cm (6 ft, 3 in.)

Width: 29 cm (2 ft, 3 in.)

Depth: 79 cm (2 ft, 7 in.)

Weight: 329 kg (725 lbs) 
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Characteristic Specification

Electrical

Voltage: 100/120/230 VAC

Power: 1350 VA or less

Frequency: 50 to 60 Hz

Computer

Minimum requirements: Pentium P3 500 MHz or equivalent
One CD ROM drive
USB (2.0) connector
128 megabytes of RAM
2-gigabyte hard drive
1024 x 768 video display capability 
Windows® 7, Windows XP, or Windows Vista operating system 
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2.  USER INTERFACE

This chapter contains information to familiarize you with the hardware and software of the 
DVVA II analyzer. It is recommended that you read this chapter before attempting to operate the 
analyzer.

Controls, Indicators, and Connectors

Front Panel

Fault indicator Illuminates when an error condition is present; for example, the 
safety shield may not be in place. The analyzer will not operate 
until the fault condition is cleared and the Reset button pressed.

Active indicator Illuminates when an automatic operation is in progress

Ready indicator Illuminates when the analyzer is in a safe state and ready for the 
next operation

Emergency Stop This button should be used in the event of an emergency 
situation. Pressing this button stops all operations immediately, 
including any analysis that may be in progress.  

After an emergency stop, you must perform the following steps 
before the analyzer is operational again:

• turn the Emergency Stop button to the right to release it
• press the Reset button
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Reset Enables you to reset the analyzer to a ready state; this button must 
be pressed every time you close the shield and begin an 
operation.

Power switch and 
indicator

Turns the analyzer on and off; the power indicator illuminates 
when power is on.

Tray drawer For placement of the lower piston tray (during analysis), and the 
disposal tray (after analysis) to collect the sample

This drawer must be completely closed before the analyzer will 
operate.
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Rear Panel   

USB port

Power 
connector

Voltage 
selection

Circuit 
breakers

Test points

Master  
power 
switch

USB port For connecting the communications cable to the computer

Voltage selector switch Enables you to select the correct operating voltage

Power connector For connecting the power cord

Actuator and lower
piston circuit breakers

A trip of one of these breakers may indicate a motor failure. 
Should this occur, wait a few minutes, reset the breaker, and retry 
your operation. If the breaker trips again, contact your service 
representative.

Test points For service personnel only

Master power switch Master power for the analyzer
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Sample Compartment

The sample compartment contains the sample chamber and the piston, and is enclosed with a 
safety shield. 

Upper piston 

Safety shield

Sample chamber

Safety shield This shield slides up to open and down to close. This shield  must 
be in a fully closed position before the analyzer will operate.

Upper piston Drives the sample down through the chamber for analysis

Sample chamber The chamber into which the sample is placed for analysis
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Safety Warning

This warning label is affixed in various locations on the DVVA II analyzer. Safety interlocks are 
in place to prevent the pistons from operating when the safety shield is not completely lowered or 
when the tray drawer on the front of the analyzer is not fully closed.

• Do not attempt to interfere with or modify the safety interlock system

• Do not try to stop the motion of the piston with your hands or with any object

• Do not place your hands or any object in the path of the piston

Any of these actions could cause severe bodily harm or damage to the analyzer. 

Turning the System On and Off 

So that the presence of all components are recognized, turn the system on and off as follows. It is 
not necessary to turn on and off the master power switch on the rear panel of the analyzer for nor-
mal operations.

Turning On 

1. Turn on the computer. 

2. Place the On/Off switch on the front panel in the On position.

3. Allow approximately 30 seconds for all components to connect to the computer, then start 
the application.

When the instrument is being shut down for an extended period of time or is being 
turned on for the first time or after loss of power, please refer to the “Full Power-On 
Procedure” on page 9-4

If the master switch has been inadvertently turned off, or the USB cable disconnected, 
turn on the master power switch and connect the cable before proceeding to Step 2.
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Turning Off

1. Exit the application.

2. Place the On/Off switch on the front panel in the Off position.

3. Turn off the computer.

Software

The DVVA II analysis program operates in the Windows environment and requires familiarity 
with standard Windows operations. This manual provides brief instructions for standard opera-
tions. Refer to your Windows documentation or the Windows help system to clarify functions 
which are specific to Windows.  

Shortcut Menus

Shortcut menus (sometimes referred to as pop-up menus) are available for onscreen graphs, tab-
ular reports, and certain components on the instrument schematic. These menus are accessed by 
right-clicking in the graph or table area, or on components on the instrument schematic. For 
example, right-click in the graph area of an onscreen report and the following menu is displayed.

You can also use the key combination Shift + F9 to access the shortcut menu. 

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations 
(if assigned) are listed to the right of the menu item. Instead of opening the menu and choosing 
the command, simply press the key combination. For example, to open a sample information file, 
press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an underlined letter 
by pressing Alt plus the underlined letter in the command. For example, to access the File menu, 
press Alt, then F.

Table 2-1 lists the shortcut keys available for operating the DVVA II 4000 program. 
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Table 2-1. Shortcut Keys

Key(s) Function

F1 Access operator’s manual 

F2 Open a sample information file (main menu bar)

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file (main menu bar)

Insert the current date (Select Dates dialog)

F4 Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start a report

F9 Close all open reports

Alt + F4 Exit the DVVA II program

Shift + F2 List statistics for sample information files

Shift + F3 List statistics for analysis conditions files

Shift + F5 List statistics for report options files

Shift + F9 Displays the shortcut menu for onscreen reports and for manual control 
components on the instrument schematic
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Dialog Boxes and Subdialog Boxes

Dialog boxes are displayed when an item followed by an ellipsis (...) is selected. Subdialog boxes 
are displayed when a push button on a dialog box is selected.

Both types of dialogs may contain one or more of the following:

Data entry field These fields may be numeric (numbers only) or alphanumeric 
(numbers, letters, or printable characters). 

Push button Typically, a push button is used to display a subdialog box in 
which to edit, enter, or specify additional information about the 
subject matter like the Add Log Entry push button shown 
above. Some push buttons, however, are used to invoke an 
action; for example, Save saves entries in the current dialog. 

Dialog box

Subdialog box
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Radio button Radio buttons allow you to choose one option from a group of 
two or more.

Some radio buttons enable data entry fields in which values are 
to be entered. 

Check Boxes Check boxes also are used to select options; you may select as 
many items as you wish.

Drop-down lists A drop-down list is indicated by a down arrow to the right of 
the field. Drop-down lists contain a list of options from which 
you may choose one.

Information Bar Some dialog boxes contain information pertinent to the 
selected field in an information bar across the bottom of the 
dialog. For example, a range is shown for fields in which 
numeric entries are required.

Down arrow

Shows range for 
highlighted field.



Software DVVA II 4000

2-10                                                    400-42803-01 (Rev B) - July 2017

Selecting Files

Certain dialog boxes contain a Files list window which displays a list of files available for the 
current operation. One example is the Open Sample Information dialog:

Select the desired file(s) and click OK, or simply double-click on the desired file.

You can limit the number of files displayed in the Files list window by choosing one (or more) of 
the following:

• Use wildcard characters in the path name you enter in the File name field. Wildcard 
characters such as * and ? can be used to filter file names. For example, you could filter a 
list of sample files to display files beginning with C by entering C*.smp in the File name 
field.

• Enter a range of dates. Click Date Range; the Select Dates dialog is displayed.

Displays all files of 
the type in the 
Status field.

The Status drop-
down list does not 
appear on the Open 
dialogs for 
parameter files.

Displays the 
current 
directory.
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Select the Show Date Range radio button to enable the From and To fields so that you 
may enter a range of dates in which to display files. Alternatively, you can double-click in 
each field to display a calendar from which to choose a date. The range you specify 
remains the default until you change the dates or select Show All Dates.

The following shortcut keys are available when the Select Dates dialog is displayed (be 
sure the cursor is in the appropriate field):

• Select a file status from the Status drop-down list (displays only for sample files). 

Table 2-2. File Status and Description

F2 Clears the field

F3 Inserts the current date

F4 Displays a calendar allowing you to select a date

Selects the year

Selects the month

Click the desired date

You may change the date format by using the Date and Time function on the 
Windows Control Panel.

Status Description

All All sample information files in the specified directory and within the 
specified range of dates

Analyzing Sample information files that are currently being used in an analysis

Complete Sample information files that have been used in a completed analysis

No Analysis Sample information files that have not been used in an analysis
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• Navigate to a different directory. The current directory is displayed just above the 
Directories list box. You can change directories by double-clicking a directory in the 
Directories list box, double-clicking [...] to move up one level, or by entering the desired 
directory in the File Name field. For example, enter C:\4000\files\sample\*.smp to display 
sample files in the 4000files\sample directory on your local drive.

Selecting Reports

Reports are selected from the Report Options dialog, or any dialog containing a Selected Reports 
list. Simply highlight the report and double-click, or press the Spacebar. A report is selected 
when it is preceded with a check mark. Reports are deselected in the same manner. 

Double-click to move 
up one level.

Double-click to open 
the listed directory.

Displays the current 
directory.

Indicates a report 
is selected.
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File Name Conventions

The following table shows the file name extensions for the DVVA II program.

Table 2-3. Default File Name Extensions

File Type Extension

Sample Information SMP

Analysis Conditions ANC

Report Options RPO

Export (text file) TXT

Export (spreadsheet) XLS

Print file contents LST

List file statistics LST

The following types are available for reports saved from the Report window:

Report REP

Spreadsheet XLS

ASCII TXT
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Menu Structure

All functions for the DVVA II 4000 program are located on menus which are accessed from the 
Menu bar. Each menu contains commands, and in some cases a submenu. A submenu is indi-
cated when the command is followed by an arrow. 

Brief descriptions of each menu are provided below; refer to the chapter given in parentheses for 
a detailed description of the commands contained on that menu.

File The options on the File menu enable you to create and manage sam-
ple and parameter files. (FILE MENU, page 5-1)

Unit 1 Enables you to perform analyses and other instrument operations. 
(UNIT MENU, page 6-1)

Reports Enables you to generate, close, and open reports. 
(REPORTS MENU, page 7-1)

Options Allows you to choose sample editing mode, edit the sample defaults, 
edit the reference table, enter user models, select data presentation 
formats, and specify a location for predefined parameter files.
(OPTIONS MENU, page 8-1)

Windows Enables you to arrange the windows and icons on your screen. This 
menu also displays the names of all open windows. (page 2-15)

Help Displays information about the DVVA II 4000 program. Also pro-
vides access to the operator’s manual. (page 2-15)

Submenu

Command

Menu Bar

Menu Name
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Windows Menu

Help Menu

Tile Resizes all open windows and arranges them side by side. 

Cascade Resizes all open windows and arranges them in a stacked fashion. 
The active window is positioned on top of the stack. Each window’s 
title remains visible, making it easy to select other windows.

Arrange Icons Arranges all minimized dialogs in an orderly manner. 

Open Files Displays all currently open files. The active file is preceded with a 
check mark.

Operator’s Manual Opens the operator’s manual. 

About 4000 Displays information about the DVVA II program.
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3.  OPERATIONAL PROCEDURES

This chapter contains brief step-by-step instructions on how to:

• specify sample file defaults, this page
• create sample information files, page 3-6
• define parameter files, page 3-9 
• perform an analysis, page 3-15
• print file contents, page 3-22
• list statistics on sample or parameter files, page 3-24
• export data from a sample information file, page 3-26 
• overlay graphs, page 3-27

This chapter does not contain detailed descriptions of the dialogs used to perform these proce-
dures. Refer to Chapters 5 through 8 for dialog descriptions. Use the index to assist you in 
locating the appropriate dialog. 

Specifying Sample File Defaults

You can specify sample defaults in the Basic or Advanced format. The defaults you specify are 
the ones you see when you create a new sample file. Therefore, it is best to specify (or enter) 
parameters that you plan to use most frequently. For example; specify defaults for your most 
commonly analyzed sample material. You can always edit parameters when you create a file. The 
DVVA II 4000 application automatically generates sample information file names and uses the 
values you specify as the defaults. 

Advanced Format 

The Advanced Sample Defaults dialog consists of tabs for each parameter. Click the tab to move 
from one set of parameters to another. The values you specify in the parameter portions (Analy-
sis Conditions and Report Options) of the sample file are saved as the defaults for newly created 
parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, then Yes to create the file, and the defaults 
you specify display for all parameters.

• Select File > Open > Analysis Conditions, name and create the file, and the defaults you 
specify in the Analysis Conditions portion of the Advanced Sample Defaults dialog 
display in the fields.

Refer to Advanced, page 8-6 for a description of the fields associated with specifying defaults 
for sample information files in the Advanced format.
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1. Select Options > Sample Defaults, the Advanced Sample Defaults dialog is displayed.

2. In the Sequence Number field, specify a default string for the sample file number; you can 
use up to eight characters. This is the number that appears in the File name field when you 
select File > Open > Sample Information.

3. In the right-side field of the Sample line, enter a format for the sample’s identification. You 
can enter up to 42 characters. Include the $ symbol if you want the sample file number 
(Sequence) included as part of the identification.

4. Edit the Operator and Submitter lines if desired. Select Omit to remove them from the 
sample file editor.

5. The Bar Code field enables you to enter bar code information. If bar code information is not 
used, you can use this field to enter additional information about the sample; for example, 
you may wish to enter the lot number of your sample.

This field, as well as other fields on the dialog, accepts data from a bar code reader. A bar 
code reader can be attached to one of the USB connectors on the computer. Simply scan the 
bar code and the number transfers to the highlighted field.

The label for this field may be customized to display differently or omitted from displaying 
at all using the options available in Sample Defaults, page 8-6.

6. Enter the mass of the sample; 1.0000 gram, ± 0.05 (determined to nearest 0.0001 gram) is the 
recommended amount of sample to use.

These labels can be 
edited. For example, you 
may wish to use Material 
in place of Sample.

You also can edit the word Sample. For example, you may prefer to use Material or 
Test. You can enter up to 15 characters in this field.
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7. Enter values in the Skeletal Density and Bulk Density fields that are typical of your sample. 
These values, like all other values, can be edited in the sample file.

8. Select the appropriate material from the Material Properties drop-down list. The Material 
type is used to determine which carbon property models are used for this particular carbon. 
For example, a different equation is used to predict COAN for Tread/Hard carbons than for 
Carcass/Soft carbons. If you select Other, the COAN is not calculated. 

9. If you plan to report statistical process control (SPC) information, enter appropriate 
information in the User Parameter fields. These user-definable parameters enable you to 
track statistical process control data; refer to Sample Defaults, page 8-6 for additional 
information.

10. Click the Analysis Conditions tab. Choose the analysis conditions appropriate for your most 
commonly analyzed material.

11. Click the Report Options tab. Choose the desired reports, using Edit to specify details; then 
click Save. 

12. Click Close to close the dialog.
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Basic Format

Perform the following steps to define defaults for a sample information file in the Basic format. 
The defaults you specify in this format also display as the defaults for sample files in the 
Restricted format.

Refer to  for a description of the fields associated with specifying defaults for sample information 
files in the Basic format.

1. Select Options > Sample Defaults; the Basic Default Sample Information dialog is 
displayed.

2. In the Sequence Number field, specify a default string. This is the number that is 
incrementally sequenced and displays in the File name field when you select File > Open > 
Sample Information. You can use up to eight characters.

3. In the field on the right of the Sample line, enter a format for the sample identification. 
Include the $ symbol if you want the sample file number included in the identification. You 
can use up to 42 alphanumeric characters.

4. Select the down arrow to the right of the Analysis Conditions and Report Options fields to 
choose previously defined parameter files as your default files.

5. Enter the mass of the sample; 1.0000 gram, ± 0.05 (determined to nearest 0.0001 gram) is the 
recommended amount of sample to use.

You also can edit the word Sample. For example, you may prefer to use Material or 
Test. You can enter up to 15 characters in this field.
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6. Enter values in the Skeletal Density and Bulk Density fields that are typical of your sample. 
These values, like all other values, can be edited in the sample file.

7. Select the appropriate material from the Material Properties drop-down list. The Material 
type is used to determine which carbon property models are used for this particular carbon. 
For example, a different equation is used to predict COAN for Tread/Hard carbons than for 
Carcass/Soft carbons. If you select Other, the COAN is not calculated. 

8. The values and options shown for the Scan Rate, Ending Pressure, Recording Interval, 
Use Prior Blank, Measure Residual Volume, and Time Between Cycles fields are the ones 
specified in the Analysis Conditions file you selected as the default.

9. The reports shown selected with a check mark in the Selected Reports window are the ones 
selected in the Report Options file you chose as the default.

10. Click Save, then Close.
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Creating Sample Information Files

A sample information file must be assigned to every sample that is analyzed. When you create a 
sample file, you can accept the default values or edit them as desired. You can create a sample 
information file using the Advanced, Basic, or Restricted format. 

Advanced Format

The Advanced format allows you to customize the parameters of a sample information file. Refer 
to Advanced, page 5-4 for a description of the fields associated with creating sample informa-
tion files in the Advanced format.

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field; you can 
use up to eight characters.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed.

The values that appear in the fields are the ones specified in Sample Defaults. 

4. Accept the default identification in the Sample field or change it to an appropriate one. The 
dialog in Step 3 shows the sample file number because the dollar ($) symbol was used when 
specifying sample defaults.

5. Edit the Operator and/or Submitter fields as needed.

These fields do not 
display if you individu-
ally selected Omit 
when specifying sam-
ple defaults.

If a sample information file already exists containing the values you wish to use in this 
file, you can click Replace All to copy them into this one. You can still edit the values 
after they are imported.  
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6. The Bar Code field enables you to enter bar code information. If bar code information is not 
used, you can use this field to enter additional information about the sample; for example, 
you may wish to enter the lot number of your sample.

This field, as well as other fields on the dialog, accepts data from a bar code reader. A bar 
code reader can be attached to one of the USB connectors on the computer. Simply scan the 
bar code and the number transfers to the highlighted field.

The label for this field may be customized to display differently or omitted from displaying 
at all using the options available in Sample Defaults, page 8-6.

7. Enter the mass of the sample; 1.0000 gram, ± 0.05 (determined to nearest 0.0001 gram) is the 
recommended amount of sample to use.

8. Edit the Skeletal and Bulk densities if needed.

9. Choose the type of sample material you are analyzing. The Material type is used to 
determine which carbon property models are used for this particular carbon. For example, a 
different equation is used to predict COAN for Tread/Hard carbons than for Carcass/Soft 
carbons. If you select Other, the COAN is not calculated. 

10. Use the Comments window to record specifics of the analysis or its conditions. Anything 
you enter in this window is printed in the report header.

11. Click Save to save the information you entered.

12. The steps for completing the remaining parameters of the sample information file are 
explained in subsequent sections:

• Analysis Conditions, page 3-10
• Report Options, page 3-11

Simply click on the tabs to open its associated dialog.
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Basic and Restricted Formats

Sample information files are created in the Basic and Restricted formats using predefined param-
eter files. Refer to Basic, page 5-7 for a description of the fields associated with creating sample 
information files using the Basic or Restricted format.

1. Select File > Open > Sample Information; the Open Sample Information File dialog is 
displayed.

2. Accept the next sequenced file number or enter a new name in the File name field; you can 
use up to eight characters.

3. Click OK, then Yes to create the file; the Sample Information dialog is displayed. 

The defaults that appear in the fields are the ones specified in sample defaults. 

4. Accept the default identification or change it to an appropriate one. The dialog above shows 
the sample file number because the dollar ($) symbol was used in Sample Defaults.

5. Click the down arrow to the right of the Analysis Conditions file and choose the parameter 
file you wish to use (or accept the default). The conditions specified in the file display in the 
Scan Rate, Ending Pressure, Recording Interval, Use Prior Blank, Measure Residual 
Volume, and Time Between Cycles fields; these values can be edited if desired.

6. Click the down arrow to the right of the Report Options field and choose the file you wish 
to use (or accept the default). The reports selected in the file you choose are shown in the 
Selected Reports window; you change the reports selected if desired. 

You can also switch to the Advanced format and edit details of the reports if you are using 
the Basic format; you cannot switch to the Advanced format if you are using the Restricted 
format.

Use this push button 
to copy parameters 
from an existing file 
into the current one.

Not displayed when using the 
Restricted format.
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7. Enter the mass of the sample; 1.0000 gram, ± 0.05 (determined to nearest 0.0001 gram) is the 
recommended amount of sample to use.

8. Edit the Skeletal and Bulk densities if needed.

9. Choose the type of sample material you are analyzing. The Material type is used to 
determine which carbon property models are used for this particular carbon. For example, a 
different equation is used to predict COAN for Tread/Hard carbons than for Carcass/Soft 
carbons. If you select Other, the COAN is not calculated. 

10. Click Save, then Close.

Creating Parameter Files

The following file types exist as part of the sample information file or as an individual parameter 
file:

• Analysis conditions, page 3-10 
• Report options, page 3-11

Having these files exist independently enables you to use them over and over again.

Several predefined parameter files are included with the DVVA II application. Although these 
files may come close to the needs of your laboratory, you may wish to define additional ones. Or 
you can use a predefined file as a starting point. This is easily accomplished by creating a new 
file and then selecting Replace. A dialog is displayed so that you can select the existing file con-
taining the values you wish to use. 

Be sure to save new parameter files to the directory specified as the Parameter Files Directory 
(see Parameter Files Directory, page 8-19) to have them display in the drop-down lists. Unless 
you have edited the parameter files directory, the files are saved to the default PARAM directory 
automatically. 

You can also create parameter files from the Advanced Sample Information dialog. For example, 
select File > Save As > Analysis Conditions to save the analysis conditions of the current sam-
ple information file as a standalone Analysis Conditions parameter file. 
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Analysis Conditions

Refer to Analysis Conditions, page 5-10 for a detailed description of the fields on this dialog.

1. Select File > Open > Analysis Conditions; the Open Analysis Conditions File dialog is 
displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description (up to 42 characters) in the Analysis Conditions field. Use an intuitive 
description, one that will help you identify the type of sample you plan to analyze using these 
analysis conditions.

5. In the Scan Rate field, enter a a rate at which pressure is to increase during analysis.

6. Enter the pressure at which to end the analysis.

7. Enter a value for the interval between points.

8. Select Use Prior Blank to skip the blank analysis performed automatically before each 
analysis; the blank data from the most recent analysis available will be used. 

9. Select the Measure Residual Volume to have residual volume measured. The Time 
Between Cycles field is enabled, allowing you to enter how long to wait before taking the 
second measurement.

10. Click Save, then Close.

When using this option, the height of the sample material in the sample chamber must 
be less than or equal to the height of the carbon for which the blank was collected.
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Report Options

Report options specify the types of reports to be generated from an analysis. They also help you 
customize details of reports such as axis scale, axis range, and column headings.

You can customize report options files to accommodate the requirements of your analyses. For 
example, you can generate a simple report that lets you determine the basic characteristics of the 
sample. Then use that report to make choices about the variables you want to include in more 
lengthy, sophisticated reports. You can generate reports automatically after analysis, or any time 
during or after an analysis. Reports generated during an analysis only include data collected up to 
the time of the report. 

Refer to Report Options, page 5-12 for a detailed description of the fields on this dialog.

1. Select File > Open > Report Options; the Open Report Options File dialog is displayed.

2. Enter a name (up to eight characters) in the File name field, then click OK.

3. Click Yes to create the file; the Report Options dialog is displayed.

4. Enter a description (up to 42 characters) in the Report Options field. Enter an identifier that 
gives a more intuitive description of the file’s contents. 

5. Select Show Report Title and enter the title you wish to appear at the top of the report. Or 
deselect this option if you prefer not to have a report title.

A report is 
selected when it 
is preceded with 
a check mark.

If your company logo exists as a bitmap (bmp) or enhanced metafile (emf), you can 
have it display in the report header by selecting Show Graphic. Click Browse to select 
the file; use the Height and Width fields to specify the size.
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6. Choose the type of pressure to be interpolated for the user defined tabular reports, the 
Summary Report, the Pressure Table Report, and the void volume normalization.

Applied: the force of the upper piston only.

Geometric Mean: the calculated geometric mean of the applied (upper piston) and transmit-
ted (lower piston) forces.

7. Click Normalize Void Volume to have the void volume data normalized to a reference 
model.

8. If you wish to compare the same type of graph from multiple files, click Overlays and 
choose the files. Be sure to edit the graph from the Selected Reports window and choose 
Samples from the Overlay drop-down list. (Refer to Generating Graph Overlays, page 3-
27 for additional information on overlays.)

9. Double-click on the report to select it (a check mark indicates selection). Reports are 
deselected in the same manner. 

You can edit some reports by highlighting and selecting the desired report; then click Edit 
(refer to Report Options, page 5-12).

10. Click Save, then Close
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Preparing the Sample

Prepare your sample but do not load it into the sample chamber until prompted. If you plan to:

• use blank data from the last analysis, you will be prompted when you click Start on the 
Sample analysis dialog.

• have the automatic blank analysis performed, you will be prompted when the blank 
analysis is completed.

1. Preheat a drying oven to 125 ºC. Place enough carbon black in the container to run your 
sample (1 gram per analysis is recommended), plus additional carbon black in case mass is 
decreased during the drying process.

2. Place the container in the oven and bake for at least one hour. 

3. When the carbon black is dry, remove the container from the oven and immediately cap the 
container. Allow the sample to cool to room temperature.

4. Place a clean scale pan on the balance; tare the balance.

5. Using a spatula, add your prepared, degassed sample to the scale pan until the balance 
displays 1.0000 gram, ± 0.05 (determined to nearest 0.0001 gram).
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6. When you start the analysis, you will be prompted by the software to load the sample. At that 
time, remove the pan from the balance and load the sample following the directions given in 
Performing an Analysis. 
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Performing an Analysis

A blank analysis is always performed prior to the analysis, unless you select the Use Prior 
Blank option. Do not place the prepared sample into the sample chamber until prompted to do 
so.

1. Wipe the upper and lower piston tips with a paper towel or Kimwipe®.

2. Insert the sample tray.

3. Close the safety shield, then press the Reset button. The analyzer will not operate if the 
safety shield is not completely closed.

4. Select Unit > Sample Analysis; the Analysis dialog is displayed with the Open Sample 
Information File dialog positioned on top. 

5. Choose a file for your analysis and click OK; the Analysis dialog containing the parameters 
of the selected file is displayed.

Use of certain USB devices or the addition or removal of a USB device during an 
analysis may cause a delay in data acquisition, resulting in a loss of data or the 
cancellation of an analysis. Avoid the use of attached USB devices such as flash 
drives, digital audio players, or cellular phones during an analysis. Additionally avoid 
adding or removing USB devices during an analysis.

You can also accept the next sequenced number and create a new file if desired. Use 
the Replace All push button to replace file parameters, or the parameter files drop-
down lists.
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6. Enter the sample weight in the Mass field and verify values for other parameters. 

7. Click Report After Analysis and choose report output options to generate reports 
automatically after the analysis. 

8. Click Export After Analysis and choose export options to export report data automatically 
after the analysis. 

9. Click Start. 

• If a blank analysis is to be run, the analysis proceeds. When the analysis is complete, the 
dialog shown in step 10 displays.

• If a blank analysis is not to be run, go to step 10.

10. A dialog prompting you to load the sample is displayed.

DO NOT click OK before completing the tasks in the dialog.     
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a. Open the safety shield and pour the prepared sample into the sample chamber; tap the pan 
to empty as much as possible.

b. Brush out the pan of any remaining sample, then brush around the funnel-shaped sample 
chamber. 

c. Wipe the brush with a Kimwipe (or other lint-free cloth) to remove sample residue.

d. Wipe the piston tip with a paper towel or Kimwipe.

e. Slide the safety shield down completely, then press the Reset button.

Sample Chamber



Performing an Analysis DVVA II 4000

3-18                                                    400-42803-01 (Rev B) - July 2017

11. Click OK on the Load Sample dialog to begin analysis on the sample; the analyzing view of 
the Analysis dialog is displayed. 
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12. When the analysis is finished, the following dialog is displayed:

a. Open the tray drawer.

b. Remove the lower piston tray, insert the waste tray to collect the sample, and close the 
drawer, click OK, then press the Reset button.
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c. After the sample has ejected, a dialog prompting you to remove the waste tray and 
replace the lower piston tray is displayed.



DVVA II 4000 Performing an Analysis

400-42803-01 (Rev B) - July 2017                                                 3-21 

d. Do as instructed, click OK, then press the Reset button. Be sure to clean the lower piston 
tip before inserting back into the drawer.

13. When the analysis is finished, a screen similar to the following is displayed. 

Click:

• Report to view the results.
• Next to perform another analysis; then click Browse to choose the next sample file.
• Close to close the dialog.
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Printing File Contents

Print enables you to print the contents of one or more sample or parameter files to the screen, a 
printer, or a file. The print dialog is common to all file types. 

Perform the following steps to print the contents of a sample or parameter file:

1. Select File > Print > (File type); a dialog similar to the one shown below is displayed.

2. From the Files list window, choose the desired file(s). You can choose multiple files, by 
holding down Ctrl while making your selections.

3. At the Destination field, click on the down arrow and choose a destination for the list output. 

• File: enter a name in the File name field, or accept the default name. 

• Printer: enables the Copies field allowing you to print up to four copies to a printer.

• Screen: prints to the computer screen

Displays the type of 
file on which you 
requested informa-
tion; in this example a 
Sample Information 
file.

Does not display for 
Parameter files.
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4. Click OK, file contents are sent to the selected destination; this example shows an Analysis 
Conditions file printed to the Screen.

Close: closes the dialog

Print: prints the report to the default printer

Header: toggles the header on and off

Prev and Next: enabled when the report contains multiple pages allowing you to advance to 
other pages
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Listing File Statistics

List enables you to generate a list of the following information on one or more sample or param-
eter files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

The List dialog is common to all file types. Perform the following steps to generate a list of file 
statistics:

1. Select File > List > (File type); a dialog similar to the one shown below is displayed.

2. From the Files list window, choose the desired file(s). If you wish to include all files in the 
list, leave all files deselected.

3. At the Destination field, click on the down arrow and choose a destination for the output. 

• File: enter a name in the File name field, or accept the default name. 

• Printer: enables the Copies field allowing you to print up to four copies to a printer.

• Screen: prints to the computer screen

Displays the type of 
file on which you 
requested informa-
tion; in this example a 
Sample Information 
file.

Does not display for 
Parameter files.
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4. Click OK, a list for the requested file(s) is sent to the selected destination; this example 
shows a sample file sent to the Screen.

Refer to Tool Bar, page 7-15 for an explanation of the buttons on the tool bar.

This column is empty for parameter files.
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Exporting Data

The Export option on the File menu allows you to copy the data in the sample information file 
and reformat it in ASCII text. 

The output file consists of data from the corrected data, blank analysis, and sample analysis.

• Corrected data has four columns: Corrected Height, Corrected Applied Pressure, 
Corrected Transmitted Pressure, and Corrected Void Volume.

• Data for the blank analysis and the sample analysis are generated in eight columns: 
Elapsed Time, Height, Applied Force, Transmitted Force, Applied Pressure, Transmitted 
Pressure, Chamber Temperature, and Ambient Temperature. 

1. Select File > Export; the Export Sample File dialog is displayed.

2. From the Files list window, select the file(s) you wish to export. To choose multiple files, 
hold down Ctrl while making your selections.

3. Choose an output destination. 

• File: enter a name in the File name field, or accept the default name. If you have selected 
multiple files, each file is exported as its file name with the appropriate File Type 
extension.

• Printer: enables the Copies field allowing you to print up to four copies to a printer.

• Screen: prints to the computer screen.

4. From the File Type list, choose whether you wish to export the data as a text file, or in a 
spreadsheet format.

5. Click OK to export the file(s) to the specified destination.
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Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or multi-
ple graphs for one sample. 

Graph overlays can be implemented in two ways:

• Multiple-Sample Overlays 
Overlay results for up to eight samples on top of a previously selected sample. 

• Multiple-Graph Overlays
Overlay two different types of graphs from one sample. 

You must use the Advanced format to specify graph overlays. 

Multiple-Samples Overlay

This type of overlay enables you to choose up to eight sample files from which to overlay data of 
the same type as the currently selected one.

1. Open the desired file. If your dialog is in the Basic format, click Advanced to switch to the 
Advanced format.

2. Click the Report Options tab to display the Report Options dialog.

3. Select reports as desired.
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4. Choose the type of graph you wish to overlay, then click Edit (this example shows Pressure 
Applied vs. Time).

5. Click the down arrow to the right of the Overlay field and choose Overlay Samples.

6. Select any other desired options on the dialog, then click OK to return to the Report Options 
dialog.

7. Click Overlays; the Graph Overlay Samples dialog is displayed.

8. Click Browse to the right of the Sample 1 field; the Plot Overlay Sample Selection dialog is 
displayed.

9. Choose a sample file, then click OK. You may choose up to eight files in this manner.

10. After selecting the desired number of sample files, click OK to return to the Report Options 
dialog.

11. Click Save to save your selections, but saving them is not necessary to view overlay results. 

12. Select Reports > Start Report. The Start Report screen is displayed with the name of your 
primary file in the File name field. 

13. Choose the output destination, then click OK; the Select Reports dialog is displayed.

14. Ensure that the desired graph is selected (preceded with a check mark), then click OK.

Use the Clear push 
button to clear the 
field of its entry.
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Multiple-Graphs Overlay

This type of overlay enables you to overlay two graphs in the same file.

1. Open the file containing the data you wish to use in the overlay. If your dialog is in the Basic 
format, click Advanced to switch to the Advanced format.

2. Click the Report Options tab to display the Report Options dialog.

3. From the Selected Reports list, select the graph you wish to use in the overlays, then click 
Edit. A Report Options dialog for that report (or graph) is displayed.
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4. Click the down arrow at the Overlay field and select a graph type from the list. This 
selection will be overlaid on the graph selected in the Y-Axis field.

5. Click OK to return to the Report Options dialog.

6. Click Save to save your selections, but saving them is not necessary to view overlay results. 

You must click Save if you are specifying overlay options on a file that has not been used in 
an analysis. For example, you may be creating a Report Options file containing overlay 
options that you can load into a sample file as needed.

7. Select Reports > Start Report; the Start Report screen is displayed with the name of your 
primary file in the File name field. 

8. Choose the output destination, then click OK; the Select Reports dialog is displayed.

9. Ensure that the desired graph is selected (preceded with a check mark), then click OK.

These two graphs 
will be overlaid.
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4.  SOFTWARE AND SETUP MODIFICATION

This chapter describes how to:

• install the software
• use the Setup program for other functions, page 4-10

Installing the Software

The DVVA II program can also be installed on a computer other than the one controlling the ana-
lyzer. This allows you to:

• create or edit sample and parameter files
• generate reports on completed sample files

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of another 
copy of the DVVA II program.

1. Insert the software installation CD into the CD-ROM drive of your computer. 

2. Select Start from the Status bar, then Run from the Start menu.

3. Enter the drive designator for the CD-ROM drive, followed by setup. For example:

     e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select setup.exe.

4. Click OK; the New Installation dialog is displayed.

Do not attach the USB cable between the computer and the instrument until the 
software has been installed and the computer restarted.

Proceed to Step 4 if AutoPlay is enabled on your computer; Setup will start
automatically and display the New Installation dialog.
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The Destination Folder group box displays the amount of current disk space, the amount of 
disk space required for the analysis program, and the directory into which the application 
will be installed. If you wish to install the application into a different directory, click Browse 
to choose the directory.

5. Select the check box just below the Destination Folder group box to add an icon to your 
desktop; this enables quick access to the analysis program.

6. The application icon is added to the Micromeritics folder by default. If you prefer a different 
folder, enter or select one from the drop-down list.

7. The Install this application for All Users check box enables you to allow or prohibit users 
other than the installer to access the application.

• Select the check box to allow access for all users logged onto Windows.
• Deselect the check box to allow access for only the user installing the application.

Deselect to restrict operation of the application to the 
person logged into the operating system at the time of 
installation.

Displays the amount of current 
disk space and the amount 
required for installation of the 
application. Also displays the 
directory into which the applica-
tion is installed.

Adds DVVA Windows icon to 
the desktop
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8. Click Next; the Analyzer Configuration dialog is displayed.

9. In the Step 1 group box, ensure that 1 is selected.

10. In the Step 2 group box, enter the serial number (located on the rear panel of the analyzer). 

11. Click Next; the Calibration File Installation dialog is displayed. Read the information 
displayed on the dialog and proceed accordingly. 

12. The Installation Complete dialog containing the Readme file will display when installation 
is complete. This dialog may also contain other important notices. After reading the 
information contained in this dialog, click Finish; for:

Choose 0 (zero) if you are installing this program for data reduction on a computer 
other than the one controlling the analyzer.

If you select 0 as the number of instruments, the calibration dialog does not display.

Windows XP 
operating system

A screen containing the Micromeritics logo is displayed for 
a brief period and then closes.

Windows 7 and
Windows Vista
operating systems

The following dialogs may display, depending on the 
security settings on your computer.
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Click the Install this driver software anyway option; the 
screen containing the Micromeritics logo closes. After a 
brief period, this dialog is displayed: 

Click This program installed correctly to close the dialog.
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13. The CAN driver Setup Wizard is displayed.

14. Click Next.

15. If the CAN driver Setup Wizard indicates that an older version of the software was detected, 
click Yes on the following dialogs to uninstall the older CAN driver version. Otherwise, skip 
to step 16.
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16. The License Agreement window is displayed.

Read the License Agreement for the CAN drivers, select I accept the agreement, then click 
Next.
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17. The Select Destination Location window is displayed. This window enables you to select the 
folder in which the drivers program will be installed.

Click Browse to choose another folder or click Next to use the default folder.

18. The Select Start Menu Folder window is displayed. This window enables you select the 
folder in which the program shortcuts will be installed.

Click Browse to choose another folder or click Next to use the default folder.
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19. The Select Additional Tasks window is displayed.

Select the icons to be created, then click Next.

20. The Ready to Install window is displayed.

Click Install.
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21. The Windows Security window is displayed.

Select Always trust software from "IXXAT Automation GmbH", then click Install.

22. The Completing the VCI Setup Wizard window is displayed.

23. Click Yes, restart the computer now, then click Finish.

24. After installation and instrument verification are complete, remove the program CD and 
store in a secure location. The original program CD contains the calibration files specific to 
your instrument. Upgrade CDs do not contain calibration files. Therefore, it is important that 
you maintain your original program CD in a secure location in the event calibration files 
need to be reinstalled. 
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Using the Setup Program for Other Functions

After initial installation of the DVVA II 4000 program, the application setup program can be 
used to:

• Upgrade software, page 4-12
• Add an Analyzer, page 4-13
• Move an analyzer from one computer to another computer, page 4-14
• Remove an analyzer from the computer, page 4-17
• Reinstall calibration files, page 4-18
• Uninstall the analysis program, page 4-19

Change Analyzer Setup and Reset Security to Default menu items are not applicable for the 
DVAAII 4000.

To start the application setup program:

1. Ensure that the analysis program is not operating and the analyzer is idle.

2. Insert the CD-ROM into your CD-ROM drive.

3. Select Start from the Status bar, then Run from the Start menu.

4. Enter the drive designator of the CD-ROM drive, followed by setup. For example: e:setup.

Alternatively, you can click Browse, navigate to your CD-ROM drive, and select setup.exe.

5. Click OK; the setup Welcome screen showing the options available is displayed.

Proceed to Step 5 if AutoPlay is enabled on your computer; Setup will start 
automatically and display the New Installation dialog.
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6. Select the operation you wish to perform. Procedures for performing each operation are 
located in subsequent sections.

After the requested operation is completed, the setup Welcome screen is again displayed. A 
confirmation message indicating completion of the operation is shown in the lower section 
of the dialog.

7. After you have completed all desired operations, click Exit to close the dialog.

Indicates status of 
last operation.
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Installing Subsequent Software Versions

When you install a software upgrade, existing data files are not overwritten. There are three types 
of subsequent installations; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 4-
10.

2. Choose the software option (only the applicable option is displayed); it will be one of the 
following:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

3. Click Start File Installation; the application installs the software and the setup Welcome 
dialog is displayed. If no other operations are desired using this dialog, click Exit to close the 
dialog.
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Adding an Analyzer

This option it not available if a DVVI II 4000 is currently installed on the computer. If however, 
no analyzer is currently installed on the computer, either from removing the analyzer using the 
setup program, or if the software was originally installed with 0 instruments, you may use this 
option to attach an analyzer to the computer.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 4-
10.

2. In the Setup dialog choose Adding an Analyzer. The Setup analyzer being added dialog is 
displayed. 

3. Enter the serial number of the analyzer, then click Next. The analyzer is added and the 
Welcome screen is again displayed.

4. Click Exit to close the dialog.
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Moving an Analyzer from one PC to another PC

You can move your analyzer, along with its status files, from one computer (Source PC) to 
another computer (Destination PC).

1. Install the analysis program on the destination computer. Refer to Installing the Software, 
page 4-1. Be sure to select 0 as the number of instruments; all related instrument information 
will be transferred in the Move operation.

If the analysis program is already installed on the destination computer, proceed to Step 2.

2. Start the application setup program on the source computer. Refer to Using the Setup 
Program for Other Functions, page 4-10.

3. In the Setup dialog, select Move an analyzer from one PC to another PC, then click Next; 
the Move analyzer operation dialog is displayed.

4. Select Source PC, then click Next; the following dialog is displayed.

This operation does not move sample or parameter files. To move these files, use a 
file management program such as Explorer or a backup/restore utility.
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5. In the Step 1 group box, select the analyzer that is to be moved.

6. In the Step 2 group box, choose a location in which the moved files will be stored. If 
possible, choose a drive that will accommodate removable media or a shared network drive. 
If this is not possible, select a local folder. After the files are placed there, use a folder 
transfer utility to copy this folder from the Source PC to the Destination PC.

7. Click Next; the files are moved and the setup Welcome screen is displayed.

8. Start the application setup program on the destination computer.

9. In the Setup dialog, select Move an analyzer from one PC to another PC; the Move 
analyzer operation dialog is displayed (shown on previous page).

10. Select Destination PC, then click Next; the following dialog is displayed.
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11. In the Step 1 group box, enter the serial number of the analyzer you are moving to this PC.

12. In the Step 2 group box, click Browse and choose the location of the moved files.

13. Click Next; the files are moved and the setup Welcome dialog is displayed.

14. Click Exit to close the dialog.
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Removing the Analyzer

You can remove the analyzer from the computer as follows. When you remove the analyzer, the 
status files also are removed; data files are not.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 4-
10.

2. From the Setup dialog, select Remove an analyzer, then click Next; the Remove an analyzer 
dialog is displayed.

3. From the drop-down list, choose the serial number of the analyzer you want to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is again displayed.

5. Click Exit to close the dialog.
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Reinstalling Calibration Files

Calibration files specific to the analyzer are contained on the original program CD; they are not 
contained on an update CD. It is important that you store your original program CD in a safe 
location. Part numbers for CDs containing calibration files have a suffix of 99. Part numbers for 
Update CDs have a suffix of 00.

Reinstall calibration files as follows:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 4-
10.

2. Select Re-install calibration files for an analyzer, then click Next; the Re-install 
calibration files dialog is displayed.

3. Ensure that the CD drive is displayed as the Calibration file source location. If not, click 
Browse and choose the CD drive.

4. Click Next; the calibration files are reinstalled and the Welcome dialog is displayed.

5. Click Exit to close the dialog.

If you did not use the original program CD to start the Setup program, you will have to 
insert it now since it contains the calibration files. You do not have to exit the Setup 
program. Simply remove the CD and insert the program CD.
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Uninstalling the Analysis Program

When you uninstall the DVVA II program, the application removes the analysis program, status 
files, analyzer setup files, and resulting empty directories. It does not remove data files. Perform 
the following steps to uninstall the program:

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 4-
10.

2. From the Setup dialog, select Uninstall, then click Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.
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4. Choose one of the following:

• Automatic: click Next; the Perform Uninstall dialog is displayed confirming the uninstall 
operation. Click Finish to uninstall the analysis program; the setup Welcome dialog redis-
plays.

• Custom: click Next; a series of dialogs is displayed, allowing you to choose the files you 
wish to uninstall. After all files are selected and uninstalled, the setup Welcome dialog 
redisplays.

5. Click Exit to close the Welcome dialog.
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5.  FILE MENU

The File menu contains options which allow you to manage sample and parameter files.

Description

Open Open an existing sample or parameter file, or create a new one. Page 5-2.

Save Save the file in the active window. Page 5-27.

Save As Save the file in the active window as a different name, or a subset of the 
sample file as a parameter file. Page 5-27.

Save All Save all open files. Page 5-27.

Close Close the file in the active window. Page 5-27.

Close All Close all open files. Page 5-27.

Print Print the contents of a sample or parameter file. Page 5-28.

List Generate file statistics for sample or parameter files. Page 5-30.

Export Export analysis data. Page 5-32.

Exit Exit the DVVA II application. Page 5-33.
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Open

Open allows you to create a new sample or parameter file, or to open an existing one. 

When you open a sample or parameter file, a dialog similar to the one shown below is displayed. 

File name For sample information files: contains the next sequenced file 
name (number) generated by the software. If this is a new 
file, you can accept this number or you can enter a name 
consisting of up to eight characters.

For parameter files: displays an asterisk (*) and a default 
extension:

*.ANC for analysis conditions
*.RPO for report options

If this is a new file, enter a name in the File name field. You 
can enter up to eight characters. 

Status
Date Range
Directories

Refer to Selecting Files, page 2-10 for a description of these 
fields.

Title bar indicates the type 
of file you are opening; in 
this example, a Sample 
Information file.

Does not display when opening 
parameter files.
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Sample Information

Sample information files consist of the following:

• sample identification
• analysis conditions
• report options

Parts of the sample information file can also exist as parameter files which are separate from the 
sample information file itself. Having these files exist independently allows you to use them as 
many times as you wish. For example, if you typically use the same analysis conditions for many 
of your analyses, you can create an analysis conditions file containing those conditions. Then 
when you create your sample file, select that file for your analysis conditions. After it becomes 
part of the new sample file, you can edit it in any way you wish without changing the file from 
which it was copied.

Sample information files are presented in three formats: Advanced, Basic, and Restricted.

• Advanced 
Presents all parts of the sample information file in a tabbed dialog, allowing easy access to 
each parameter. Use this format to customize files.

• Basic 
Presents the sample information file in a single dialog. This format allows you to quickly 
create a sample information file using previously defined parameter files. You also can 
switch to the Advanced format to view or edit parameters.

• Restricted 
Presents the sample information file in a single dialog similar to the Basic format. This 
format, however, does not allow you to switch to the Advanced format. Some menu items 
also are unavailable.

Files list Lists the files contained in the selected directory of the type 
chosen in the Status field and within the selected date range. 
The first column in the list is the file name (number). The 
second column is the description entered in the file. 

If you are opening an existing file, simply select the file and 
click OK (or double-click on the file).

Specify or change your format by selecting Options > Option presentation.
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Advanced

The Advanced format displays all parts of the sample file in a tabbed dialog, allowing easy 
access to each parameter. Simply click the desired tab or use the Prev and Next push buttons to 
access the parameter dialogs. Refer to Advanced Format, page 3-6 for step-by-step instructions 
on creating a sample information file using the Advanced format.

Sample Displays the current file’s description. If this is a new file, the 
description specified in sample defaults is displayed. The 
sample file name (number) is shown in the example above 
because the dollar ($) sign was used in Sample Defaults. You 
may enter a new description or edit the existing one.

Range: 50 alphanumeric characters

Operator
Submitter

Enter the name of the operator who will be performing the anal-
ysis and the name of the person (or department) submitting the 
sample for analysis. 

Range: 40 alphanumeric characters

The label(s) for these fields can be edited or omitted from dis-
playing at all using the options available in Sample Defaults, 
page 8-6.
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Bar code This field enables you to enter bar code information. If bar 
code information is not used, you can use this field to enter 
additional information about the sample; for example, you may 
wish to enter the lot number of your sample.

This field, as well as other fields on the dialog, accepts data 
from a bar code reader. A bar code reader can be attached to 
one of the USB connectors on the computer. Simply scan the 
bar code and the number transfers to the highlighted field.

Range: 40 alphanumeric characters

The label for this field may be customized to display differently 
or omitted from displaying at all using the options available in 
Sample Defaults, page 8-6.

Mass Enables you to enter the mass of the sample; 1.0000 gram, ± 
0.05 (determined to nearest 0.0001 gram) is the recommended 
amount of sample to use.

Skeletal Density Enables you to enter the skeletal density (also known as the true 
density) of your sample.

Bulk Density Enables you to enter the bulk density (sometimes referred to as 
pour density) of your sample.

User Parameters The fields in this group box can be used for SPC (Statistical 
Process Control) reporting. They are used to specify character-
istics of the sample or its manufacturing process, as well as to 
enter constants to be included in User Model formulae.

Once specified, these parameters display on the sample editor 
and in the SPC Sample Options dialog.

These fields can also be used to record analysis conditions or 
sample information so that it can be printed on the Summary 
report.

If desired, you can have these fields omitted from the sample 
information file (refer to Sample Defaults, page 8-6).

Comments Enter comments about the sample or its analysis conditions. 
Comments entered here are printed in the header of the reports. 
This field will accept up to 500 characters.
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Material Properties Enables you to choose the type of sample material you are 
analyzing.The Material type is used to determine which carbon 
property models are used for this particular carbon. For 
example, a different equation is used to predict COAN for 
Tread/Hard carbons than for Carcass/Soft carbons. If you select 
Other, the COAN is not calculated. 

Choose Other only when your material is something other than 
Tread/Hard or Carcass/Soft.

Add Log Entry Displays the Add Log Entry dialog

This dialog enables you to enter analysis and/or sample criteria 
(not recorded automatically by the analysis program) to display 
in the Sample Log report. You can make multiple entries by 
selecting this push button as many times as you wish.

Replace All Allows you to replace the values of the current sample file with 
those from an existing one. A dialog is displayed so that you 
may select the file. The values are copied into the file; you may 
edit them as needed. This replaces all parameters of the entire 
sample information file.

Each of the individual tabbed dialogs contain a Replace push button if you wish only 
to replace specific parameters and not the entire contents.

Save Saves the information you have specified for this sample file.

Close Closes the dialog. If a file containing unsaved changes is 
open, you are prompted to save before the dialog closes.

Basic Displays the sample information file in the basic format.
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Basic

The Basic format displays all parameters in a single, non-tabbed dialog. This format allows you 
to create a sample information file using previously defined parameter files. You can also switch 
to the Advanced format to view or edit parameters. 

Refer to Basic and Restricted Formats, page 3-8 for step-by-step instructions for creating a 
Basic sample information file.

Sample Displays the current file’s description. If this is a new file, the 
description specified in sample defaults is displayed. You may 
enter a new description or add to the existing one.

Range: 50 alphanumeric characters

Replace All Allows you to replace the values of the current sample file with 
those from an existing one. A dialog is displayed so that you 
may select the desired file. After you have copied the values 
into the current file, you may edit them as desired.

Analysis Conditions Contains predefined Analysis Conditions files, some of which 
were included with the analysis program. If this is a new file, 
this field contains the one you specified as the default. 

Click Advanced to view or edit file values.
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Report Options Contains predefined Report Options files, some of which were 
included with the analysis program. If this is a new file, this 
field contains the one you specified as the default. 

Click Advanced to view or edit file values.

Mass Enables you to enter the mass of the sample; 1.0000 gram, ± 
0.05 (determined to nearest 0.0001 gram) is the recommended 
amount of sample to use.

Skeletal Density Enables you to enter the skeletal density (also known as the 
true density) of your sample.

Bulk Density Enables you to enter the bulk density (sometimes referred to as 
pour density) of your sample.

Material Properties Enables you to choose the type of sample material you are 
analyzing.The Material type is used to determine which carbon 
property models are used for this particular carbon. For 
example, a different equation is used to predict COAN for 
Tread/Hard carbons than for Carcass/Soft carbons. If you select 
Other, the COAN is not calculated. 

Choose Other only when your material is something other 
than Tread/Hard or Carcass/Soft.

Scan Rate
Ending Pressure
Recording Interval
Use Prior Blank
Measure Residual Volume
Time Between Cycles

These fields display the values and options for the selected 
Analysis Conditions file; they may be edited if needed. Editing 
the fields in the dialog does not change the values in the 
Analysis Conditions file. Refer to Analysis Conditions, page 
5-10 for a description of these fields.

Selected Reports Contains a list of available reports. The ones selected for the 
current Report options file are indicated with a check mark; 
you may select additional reports to generate if desired. 

Save Saves the information you have specified for this sample file.

Close Closes the dialog. If a file containing unsaved changes is open, 
you are prompted to save before the dialog closes.

Advanced Displays the sample information file in the advanced format, 
allowing you to view or edit parameters.
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Restricted Format

The Restricted format is used when analysis parameters must remain constant. A password is 
required to enter and exit this format. Refer to Restricted, page 8-5 for additional information on 
the Restricted format.

The Restricted format displays in the same manner as the Basic format. Some menu functions, 
however, are disabled and you cannot switch to the Advanced format to edit file parameters.

Refer to Basic and Restricted Formats, page 3-8 for step-by-step instructions for creating a 
Restricted sample information file

The Restricted format 
does not contain an 
Advanced push button 
allowing you to switch to 
the Advanced format.
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Analysis Conditions

This dialog enables you to specify the analysis conditions for your sample. An analysis condi-
tions file can exist as an independent parameter file or as part of the sample information file.

Be sure to save this file to the directory you specified as the Parameter Files directory 
if it is to be included in the drop-down list of the Basic Sample Information dialog (see 
Parameter Files Directory, page 8-19).

Analysis Conditions Displays the description of the current file. If this is a new file, 
the description specified in sample defaults is displayed. You 
may enter a new description or add to the existing one.

Range: 40 alphanumeric characters

Replace Allows you to replace the values in the current file with those 
from an existing one. After the values are copied into the file, 
you can edit them as required.

Scan Rate Enter the rate at which pressure is to increase during analysis.

Ending Pressure Enter a pressure at which to end the analysis.

Recording Interval Enter the interval for recording data points.
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Use Prior Blank Skips the blank analysis automatically performed before each 
analysis and uses the data from the previous blank analysis.

When using this option for your sample analysis, the height of 
sample material in the sample chamber must be higher than that 
used in the blank analysis.

Measure Residual Volume Allows you to measure the void volume of the compressed 
sample. At the end of the compression cycle, the upper piston 
withdraws and a single-point measurement is collected. This 
point defines the top of compressed sample and is used to 
calculate the residual void volume.

Time Between Cycles Enter how many minutes to wait after the completion of the 
compression cycle before taking the single-point measurement.
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Report Options

This dialog allows you to specify report options for your analysis. A report options file can be 
created as an independent parameter file or as part of the sample information file. 

Be sure to save this file to the directory you specified as the Parameter Files directory 
if it is to be included in the drop-down list of the Basic Sample Information dialog (see 
Parameter Files Directory, page 8-19).

Report Options Displays the description of the current file. If this is a new file, 
the description specified in sample defaults is displayed. You 
may enter a new description or edit the existing one. Use an 
intuitive description that will help you to recognize it for future 
use. You may enter up to 40 alphanumeric characters.

Replace Allows you to replace the values in the current file with those 
from an existing one. After the values are copied into the file, 
you can edit them as needed.

Show report title Enables you to have a title appear on your report and provides a 
field for entering the text. You can enter up to 50 alphanumeric 
characters.



DVVA II 4000 Open

400-42803-01 (Rev B) - July 2017                                          5-13 

Show graphic Select this option to have a graphic display above the report 
title. The graphic can be a bitmap (bmp) or an enhanced 
metafile (emf). For example, you may wish to display your 
company logo.

Click Browse to choose the graphic, then enter the height and 
width in the appropriate fields. This image can be edited, or 
removed, from the report window.

Standard Pressure Choose the type of pressure to be interpolated for the user 
defined tabular reports, the Summary Report, the Pressure Table 
Report, and the void volume normalization.

Applied: the force of the upper piston only

Geometric Mean: calculates a geometric mean of the applied 
(upper piston) and transmitted (lower piston) forces.

Normalize Void Volume Select this option to have the void volume normalized.

Overlays Displays the Graph Overlay Samples dialog.

Click Browse to choose the file(s) you wish to use in the 
overlay. You may select up to eight files. Use Clear to clear a 
field of its entry. 

After choosing the file(s), select the Overlay samples option 
for each report type you plan to overlay. Refer to Multiple-
Samples Overlay, page 3-27 for step-by-step instructions.
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Selected Reports Contains a list of available reports:

• Summary Report
• Standard Table
• Pressure Table
• Void Vol. vs Pressure*
• Pressure Appl. vs Time*
• Height vs Time*
• Void Vol. vs Time*
• Height vs Pressure Appl.*
• Chamber Temp. vs. Time*
• Height vs. Force Appl.*
• Uncorrected Data
• Sample Log 
• Modified Heckel
• Kawakita
• Bauer
• Wu
• Cooper-Eaton

*Default names for Trend plots. These plots can be edited and 
customized as desired. Refer to Trend Plots, page 5-20 for 
details.

Highlight the desired report and double-click the left mouse 
button, or press the Spacebar to select a report. A report is 
selected when it is preceded with a check mark (); it is dese-
lected in the same manner.

Edit Displays a dialog for the selected report. Editing options for 
available reports are shown in subsequent sections.

This button is disabled for the Sample Log report and 
Uncorrected Data; the parameters for these reports cannot be 
edited.
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Summary Report

The Summary report enables you to generate a condensed report of information on COAN, user-
specified Models, density, and void volume at specified pressures.

COAN
Model 1 through 7 

Enables you to select models to appear on the summary 
report. You may select up to 8 models.

If this file is part of a sample information file, only those 
models that apply to the selected material type are contained 
in the drop-down lists.

If this file is not part of a sample information file, all models 
in the system are shown in the drop-down lists.

The Material type, selected on the Sample Information dialog 
is used to determine which carbon property models are used 
for a particular carbon. For example, a different equation is 
used to predict COAN for Tread/Hard carbons than for 
Carcass/Soft carbons. If you selected Other for Material 
type, the COAN is not calculated. 

Bulk Density Includes the bulk density calculated from the software 
determination of the top of the sample.
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Top-of-Sample Height Calculates the distance from the top of the sample chamber to 
sample contact.

Void Volume Reports the void volume at a specified pressure.

Blank Details Provides the stored parameters for the blank analysis.

Residual Void Volume Reports residual void volume of the sample. Includes the 
residual top-of-the sample height, the residual force 
measured on the lower load cell, and the hold time.

Pressure Table Enables you to specify up to 999 pressure points at which to 
interpolate collected data; less than 10 is typical. 

Use the Insert, Delete, and Clear push buttons and Ctrl + 
Down Arrow to assist you in creating your table.

Insert Inserts a line above the selected line.

Delete Deletes the selected line.

Clear Clears the table of all entries except one; one is required.

Ctrl + Down Arrow Appends a new line at the bottom of the table.
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Column [n] Enables you to select up to eight columns to appear on 
the report. The drop-down lists contain the following 
variables:

• Time
• Apparent Volume
• Pressure Applied
• Apparent Specific Volume
• Pressure Transmitted
• Apparent Density
• Pressure Mean
• Apparent Relative Density
• Force Applied
• Axial Strain
• Force Transmitted
• Void Ratio
• Force Mean
• Work Applied
• Height
• Work Mean
• Void Volume
• dV/dP Applied
• Ambient Temperature
• dV/dP Mean 
• Chamber Temperature
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Standard Table

The Standard Table report contains the data points collected during analysis and can display up 
to 8000 points. 

You can display up to eight columns on the report. The drop-down lists contain the vari-
ables listed on page 5-17.
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Pressure Table Report

The Pressure Table report allows you to enter a set of pressures at which to interpolate the col-
lected data; the Pressure Table dialog is displayed.

Pressure Table Enables you to specify up to 999 pressure points at which to 
interpolate collected data. Less than 10 is typical for most 
users.

Use the Insert, Delete, and Clear push buttons to assist you 
in creating your table.

Insert Inserts a line above the selected line.

Delete Deletes the selected line.

Clear Clears the table of all entries except one; one is required.

Ctrl + Down Arrow Appends a new line at the bottom of the table.

Column [n] Enables you to choose up to eight different variables for your 
report. The drop-down lists contain the variables listed 
on page 5-17.
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Trend Plots 

There are seven trend plots listed in the Selected Reports window. These plots can be generated 
as shown, or they can be customized. The report title is based on the parameters displayed for the 
x- and y-axes. For example, this report’s title is Void Volume (Y-axis variable) vs. Pressure 
Applied (X-Axis variable) Trend Plot.

Each time you change the X- or Y-axis variable, the change is reflected in the title bar. Graphs 
and tables will display a maximum of 8000 points. All data points will be displayed if the number 
of points is less than or equal to 8000; every other data point will be displayed if the number of 
points is in the range of 8001 to 16000; and so forth. 

X-Axis
Y-Axis

These drop-down lists contain the variables available for the 
X- and Y-axes (refer to page 5-18).

Linear
Logarithmic

Enables you to plot the axes on a linear or logarithmic scale.

Overlay Contains choices for overlaying plots. From this drop-down 
list, you can select:

• another variable to overlay with the variable shown in the 
Y-Axis field, or

• Overlay Samples to overlay data of the type selected in 
the Y-Axis field with the same type of data contained in 
other sample files. The other sample files are selected by 
clicking Overlays on the Report Options dialog.

Choose None if you are not generating overlays.

Displays the range 
for the selected field.
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Uncorrected Data Report

The Uncorrected Data report displays the data from the blank analysis and the sample analysis 
before being corrected; it cannot be edited.

Sample Log Report

The Sample Log report displays the following; it cannot be edited:

• Automatic operations
• Information entered using Add Log Entry on the sample file editor
• Warnings and/or errors which occurred during analysis

Plot curve
Plot points

Choose the manner in which data are plotted; as a curve, 
points, or both. 

Autoscale x-axis 
Autoscale y-axis

Scales the X- and/or Y-axes automatically.

Deselect Autoscale to enter a range in which to scale data.  
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Compression Reports

Compression reports allow you to have your data overlaid with model data. You can choose the 
optimize options for the equation to have the model data more closely fit the analysis data. 

Modified Heckel Report

The original Heckel equation was developed and applied on ceramic and metal materials and, 
later, modified for compaction of powders where the porosity is substituted for concentration and 
pressure substituted for time.

Model Displays equation parameters for the modified Heckel model.

Options Applied: reports the force applied from the upper piston only. 

Mean: reports the geometric mean of the force applied from the 
upper and lower pistons.

Pressure range: the pressure range on which the model is 
overlaid; defaults to entire range. 

Optimize [equation parameter]: when selected, the software 
recalculates model parameters in order to best fit the model with 
the data. 
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Kawakita Report

The Kawakita equation has received considerable attention in the field of powder compaction. It 
tends to provide a good straight line throughout the range of pressures over which they are 
plotted, although some may show curvature at the low-pressure end.

Refer to Modified Heckel Report, page 5-22 for an explanation of the fields on this dialog. 

Plot curve
Plot points

Choose the manner in which data are plotted; as a curve, points, 
or both. 

Autoscale x-axis 
Autoscale y-axis

Scales the X- and/or Y-axes automatically.

Deselect Autoscale to enter a range in which to scale data. 
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Bauer Report

Bauer proposed that the maximum void ratio, the minimum void ratio, and the critical void ratio 
are pressure-dependent. Plotting the void volume, porosity, and/or apparent density using the 
Bauer model provides a good fit for carbon black curves.  

Refer to Modified Heckel Report, page 5-22 for an explanation of the fields on this dialog. 
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Wu Report

The Wu equation was developed to describe the pressure and density dependency of soil. For 
granular soils, the stress response to a strain input depends explicitly of density, and the tangen-
tial stiffness depends on pressure in a way which is weaker than linear.

Refer to Modified Heckel Report, page 5-22 for an explanation of the fields on this dialog. 
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Cooper-Eaton Report

The Cooper-Eaton equation is based on the assumption that compression of powder is a process 
that takes place in two stages, where stage 1 is filling voids, and stage 2 is fragmentation and 
deformation of the particles.

Refer to Modified Heckel Report, page 5-22 for an explanation of the fields on this dialog. 
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Save

Saves any changes you have made to the file in the active window. The file is saved under its cur-
rent name.

Save As

Enables you to:

• save a sample or parameter file in the active window under a different name. This option is 
useful for making a duplicate copy of a file that you can modify as desired without 
changing the original one. The original file remains open when you use this function, so be 
sure to open the new file before making any changes.

• save a subset (parameter) of the sample file in the active window as a standalone 
parameter file. For example, select Analysis Conditions from the Save As menu to create a 
standalone parameter file of the analysis conditions portion of the active sample file.

Save All

Saves all open files under their current names. This option provides a faster way to save all open 
files at one time and avoids having to perform a Save operation on each individual file. 

Close

Closes the current file. The following message is displayed if changes have been made to the file:

Yes saves the changes and closes the file.
No discards the changes and closes the file.
Cancel returns you to the open file.

Close All

Closes all open files. The message shown above for Close is displayed for each file in which 
changes have been made. The same actions apply.
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Print

Enables you to print the contents of a sample or parameter file. You can choose multiple files by 
holding down the Ctrl key while making your selections. Regardless of which file type you 
select, a dialog similar to the one shown below is displayed.

File name Displays the name of the file you select from the Files list.

Status
Date Range
Files
Directories

These options are explained in Selecting Files beginning on 
page 2-10.

Settings Enables you to choose output options. Select the down-arrow 
to the right of the Destination field to choose the destination:

• Printer: enables the Copies field allowing you to print 
up to four copies to a printer.

• Screen: prints the information to the screen.

• File: generates a text file which can be viewed with a text 
editor or other text file manipulation tool. Also enables 
the File name field so that you can enter a name for the 
file (or you can accept the default).

Does not display for 
parameter files.
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This example shows an Analysis Conditions file printed to the Screen.

Close Closes the dialog

Print Prints the report to the default printer

Header Toggles the header on and off

Prev 
Next

Enabled when the report contains multiple pages allowing you to 
advance to other pages

Header



List DVVA II 4000

5-30                                                    400-42803-01 (Rev B) - July 2017

List

Generates the following information on a selected sample or parameter file. You can choose mul-
tiple files by holding down the Ctrl key while making your selections.

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

The List dialog is common to all file types. The title bar displays the type of file for which you 
have requested information.

File name If you select only one file from the Files list, the name is 
copied to this field. If multiple files are selected, the last one 
selected displays in this field.

Status
Date Range
Files
Directories

These options are explained in Selecting Files beginning on 
page 2-10.

Does not display for 
parameter files.
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This example shows a sample file sent to the Screen.

Refer to Tool Bar, page 7-15 for an explanation of the buttons on the tool bar.

Settings Enables you to choose output options. Select the down-arrow 
to the right of the Destination field to choose the destination:

• Printer: enables the Copies field allowing you to print 
up to four copies to a printer.

• Screen: prints the information to the computer screen.

• File: generates a text file which can be viewed with a text 
editor or other text file manipulation tool. Also enables 
the File name field so that you can enter a name for the 
file (or you can accept the default)

This column will be empty for parameter files.
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Export

Copies the data in a sample information file and exports it in a text (*.TXT) or spreadsheet 
(*.XLS) format. 

The output file consists of data from the corrected data, blank analysis, and sample analysis.

• Corrected data has four columns: Corrected Height, Corrected Applied Pressure, 
Corrected Transmitted Pressure, and Corrected Void Volume.

• Data for the blank analysis and the sample analysis are generated in eight columns: 
Elapsed Time, Height, Applied Force, Transmitted Force, Applied Pressure, Transmitted 
Pressure, Chamber Temperature, and Ambient Temperature. 

Select File > Export from the main menu; the Export Sample File dialog is displayed.

File name Displays the name of the file you select from the Files list. 
You can export multiple files by holding down Ctrl while 
selecting the files.

Status
Date Range
Files
Directories

These options are explained in Selecting Files beginning on 
page 2-10.

File Type Enables you to export data as a text file, or in a spreadsheet 
format.
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Exit

Exits the DVVA II program. 

• If an analysis is in progress, the following message is displayed:

Yes exits the analysis program.
No returns allow the analysis to continue.

• If a window containing a modified file is open, the following message is displayed:

Yes saves the changes and closes the file.
No discards the changes and closes the file.
Cancel returns to the open file.

Copies Enabled when you choose Printer as the destination, 
allowing you to print up to four copies to a printer.

Destination Contains a list of output destinations; you can print to a 
Printer, to the Screen, or to a File.

File name Enabled when you select File as the destination, allowing you 
to enter a name, or you can accept the default (the sample file 
name). If you are exporting multiple files, the sample file 
name is automatically assigned.
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6.  UNIT MENU

The Unit menu contains descriptions of the operations that are performed using the DVVA II 
analyzer. 

Description

The Unit menu does not appear on the menu bar if the analysis program is being used 
for offline data manipulation.

Sample Analysis Perform a sample analysis. Page 6-3.

Reference Run Perform an analysis on the SRB reference materials. Page 6-7. 

Return Upper Piston 
Home

Return the upper piston to its home position. Page 6-8.

Return Lower Piston 
Home

Return the lower piston to its home position. Page 6-8.

Clean System Clean the sample chamber. Page 6-9.
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Enable Manual Control Operate the upper and lower pistons manually. Page 6-8.

Show Instrument 
Schematic

Display the instrument schematic. Page 6-12.

Show Status Display the status portion of the operational window, enabling 
you to view the status of the operation in progress. Page 6-13.

Show Instrument Log Display the instrument log. Page 6-14.

Unit Configuration Display the configuration of the analyzer. Page 6-16.

Diagnostics For service personnel only. Page 6-16.

Calibration Perform certain instrument calibrations with assistance from a 
service representative. Page 6-17.

Normalization View data from reference runs. Page 6-19.
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Sample Analysis

Use this command to perform an analysis. A blank analysis is part of the analysis procedure and 
is performed before you add the sample material for analysis. The measured force includes 
changes in friction caused by the sample type

A blank analysis is performed to correct for this friction. You can skip the blank analysis if you 
check the Use Prior Blank option; the data from the last blank analysis will be used.

Choose a file from the Open Sample Information File dialog, or create a new one, to display the  
Analysis dialog. The fields now contain the values for the selected file or, if creating a new file, 
the specified defaults.

View Allows you to view:

• the current operation

• the instrument schematic; refer to page 6-11 for a description 
of the components on the schematic

• the instrument log; refer to page 6-14 for a description of the 
instrument log 
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Browse Allows you to select a different sample file for your analysis, or 
to create a new one.

Sample Displays the identification of the sample file.

Material Properties Defaults to the type of material you selected on the sample 
information dialog; ensure that it displays the correct type

The Material type is used to determine which carbon property 
models are used for this particular carbon. For example, a 
different equation is used to predict COAN for Tread/Hard 
carbons than for Carcass/Soft carbons. If you select Other, the 
COAN is not calculated. 

Choose Other only when your material is something other than 
Tread/Hard or Carcass/Soft.

Replace All Enables you to replace the values for all parameters of the 
current file with those from an existing file. 

Analysis Conditions Displays a description of the analysis conditions file in the 
selected sample information file. 

Use the drop-down list to select a different Analysis Conditions 
file.

Report Options Displays a description of the report options file in the sample 
information file you have chosen for this analysis. 

Use the drop-down list to select a different Report Options file.

Mass
Skeletal Density
Bulk Density

Displays the values specified in the current sample information 
file.

These values can be edited if necessary.

Scan Rate
Ending Pressure
Recording Interval
Use Prior Blank
Measure Residual volume
Time Between Cycles

Displays the values and options specified in the current 
Analysis Conditions file; any can be edited for the current 
analysis. Editing the values on this dialog will not change those 
of the Analysis Conditions file.
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Selected Reports Displays the reports selected for the current Report Options file; 
you can edit the selections if you wish. You cannot edit details 
of the reports.

Report After Analysis Generates a report automatically after the analysis; displays the 
Reports Settings dialog so that you can specify report output 
options.

Export after analysis Exports data automatically after the analysis; displays the 
Export Settings dialog so that you can specify export output 
options.

User Parameters The fields in this group box can be used for SPC (Statistical 
Process Control) reporting. They are used to specify character-
istics of the sample or its manufacturing process, as well as to 
enter constants to be included in User Model formulae.

Once specified, these parameters display on the sample editor 
and in the SPC Sample Options dialog.

These fields can also be used to record analysis conditions or 
sample information so that it can be printed on the Summary 
report.
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Cancel Enables you to cancel the analysis; a query dialog is displayed.

Click Yes to cancel the analysis or No to continue the analysis.

Prev Returns you to the Results window of the last analysis 
performed.

Start Begins the blank analysis. After completion of the blank analy-
sis, a dialog prompting you to load the sample is displayed. If 
you chose Use Prior Blank, this dialog displays when you 
select Start.

Load the sample, close the shield, press Reset, and click OK to 
begin the analysis. Do not click OK until you have loaded the 
sample and closed the shield.
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Reference Run

Use this command to perform analyses on SRB series reference materials. These reference runs 
should be performed:

• on a regular basis to compensate for wear on the piston tip. Perform two reference runs on 
each reference material monthly; or, one run on each reference material twice a month. 
This will consist of 12 runs; two each on the six reference materials.

• when you install a new piston tip. Perform four reference runs on each reference material; 
this will consist of 24 runs.

At the end of each reference run, the Reference Run dialog is displayed allowing you to choose 
the appropriate reference material and start the next run.

Data from the runs can be viewed using the Normalization option (refer to Normalization, page 
6-19).

Reference Name This drop-down list contains the SRB reference materials 
defined in the Reference Defaults table (see Reference Table, 
page 8-13).

Click the down-arrow and choose the reference material you are 
using in the analysis.
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Refer to Sample Analysis, page 6-3 for a description of the remaining fields on this dialog. 

Return Upper Piston Home

Returns the upper piston to its home position; the Return Upper Piston Home dialog is displayed.  

The dialog closes automatically when the upper piston reaches its destination.

Return Lower Piston Home

Returns the lower piston to its home position; the Return Lower Piston Home dialog is displayed.  

The dialog closes automatically when the lower piston reaches its destination.

File Displays the sample file number; numbers are assigned auto-
matically to reference runs.

Sample Displays the description assigned to the reference run. By 
default, this is the SRB series reference material name that was 
selected in the Reference Name drop-down list for this 
reference run; e.g., A-8, B-8, C-8.

Bulk density Enter the bulk density of the carbon black reference material 
you are using (refer to Appendix C, page C-1.) 
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Clean System

Cleans residual sample from the inner walls of the sample chamber; the Clean System dialog is 
displayed.

1. Wipe off the upper piston tip.

2. Remove the sample tray and insert the waste tray.

3. Press the Reset button on the instrument’s front panel.

4. Click Start on the Clean System dialog.

5. When the cleaning process is complete, all components return to a ready state and the dialog 
closes automatically.

6. Remove the waste try and empty its contents.

7. Wipe off the lower piston tip.

8. Insert the sample tray.

9. Press the Reset button on the instrument’s front panel.

Start Starts the cleaning process. The piston travels down the 
sample chamber, removing any residual sample as it 
travels. 

Cancel Cancels the operation; all components return to a ready 
state. 
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Enable Manual Control

Select this option to manually control the pistons. If the instrument schematic is not displayed, 
select Unit > Show Instrument Schematic.

The movement of the pistons is activated while the appropriate direction symbol is pressed with 
the left mouse button; movement ceases when you release the mouse button. 

Use one of the following options to move to the selectable components on the instrument 
schematic:

• click on the component
• use the Tab key or arrow keys to move to the component

A component is selected when it is surrounded by a dotted line. 

Manual Control is disabled when an automatic operation is in progress.
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Components on the instrument schematic are:

Enable you to move the pistons up and down. The piston’s posi-
tion is indicated on the schematic as you press and hold down 
the arrow with the left mouse button.

A Red state exists for the: 

• Upper and lower piston controls when lower piston tray 
is not in position  

• Upper piston descent when the lower piston is not in the 
fully up or fully down position

Represents the upper piston. The distance from the upper piston 
to the lower piston is displayed to the right of the piston icon. 
Use the Up/Down arrows (on the right side) to move the piston 
when manual control is enabled. 

Represents the sample chamber. 

The ambient temperature of the sample compartment (upper) 
and the temperature of the sample chamber (lower) are 
displayed to the left of the chamber.

Represents the lower piston and tray, indicating it is in position.

If the tray is not positioned at this level, a message displays on 
the schematic indicating it is not in position. The upper and 
lower piston controls will also be disabled (shown in red). 

Use the Up/Down arrows (on the left side) to move the piston 
when manual control is enabled.

Chamber temperature
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Show Instrument Schematic

Select this option to display a schematic of the DVVAII 4000. 

Refer to page 6-10 for a description of the components on the instrument schematic. 

These readings display to the right of the sample chamber.

A. The applied force and pressure at which the upper piston 
presses against the lower piston.

B. The transmitted force and pressure received by the lower 
piston.  

Displays the speed at which the upper piston travels. Right-click 
on the icon to display its shortcut menu, or press Shift + F9 
when the icon is selected.

Actions: Low, Medium, High

A

B
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Show Status

Select this option to show only the status portion of the operational window.

Sample ID Displays the identification of the current sample file.

Sample File Displays the name of the current sample file.

Status Displays the status of the current operation, or Idle if an opera-
tion is not in progress.

Height Displays the distance from the tip of the upper piston to the tip 
of the lower piston.

Pressure Displays the applied and transmitted pressures being applied by 
the piston.

Force Displays the applied and transmitted forces being applied to the 
piston.
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Show Instrument Log

Select this option to display a log of recent analyses, calibrations, and errors or messages. This 
information is recorded automatically by the software. By default, information for analyses and 
messages are retained 60 days, and calibration information for 90 days. You may change the time 
for which this information is retained in the [Unit 1] section of the WIN4000.INI file.

Analysis 
Calibration
Message 

Select the type of entries to display in the instrument log. For 
example, if you select Analysis, only Analysis operations are 
displayed.

Add Log Entry Use this push button to enter analysis and/or sample criteria (not 
recorded automatically by the analysis program) that you wish 
to display in the Instrument Log report. You can make multiple 
entries by selecting this push button as many times as you wish.

Report Enables you to print or display on the screen a report of log 
entries; the Log Report Settings dialog is displayed.
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Start Date Use this field to specify a date at which to begin listing entries. 
Be sure the cursor is in the Start Date field and use one of the 
following methods to specify a date:

• Type the desired date; you do not have to enter a slash ( / ).

• Double-click in the field (or press F4) to display a calendar to 
choose a date.

• Press F3 to insert the current date.

Copies Enabled when you choose Printer for the destination, allowing 
you to print up to four copies.

Destination Specify a report destination; you can print to the Screen, Printer, 
or a File.

File name Enabled when you select File for the destination, enter a file 
name.

Use this set of left/right arrows to select a year.

Use this set of left/right arrows to select a month.

Click the desired date.
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Unit Configuration

Select this option to display software/hardware configurations for the selected analyzer. When 
you select Unit > Unit Configuration, the Unit Configuration dialog is displayed.

 

Diagnostics

This command is used by Micromeritics service personnel.

Software Versions  Displays the software versions for components being 
used by the analyzer, and the serial number of the 
analyzer.

Cylinder run-count Displays the number of piston cycles for the analyzer

Upper Tip Run-count
Lower Tip Run-count

Displays the number of cycles for the upper and lower 
pistons.

Reset Enables you to reset the Tip run-count fields to zero 
after the piston tip is replaced.

Calibration Shows the date and time for current instrument 
calibrations.

 



DVVA II 4000 Calibration

400-42803-01 (Rev B) - July 2017                                                 6-17 

Calibration

The DVVA II 4000 is calibrated before it leaves the factory; calibration values and dates are dis-
played on the Unit Configuration dialog (accessed from the Unit menu). 

All but one calibration listed on this drop-down menu can be enabled and performed only with 
the assistance of a trained Micromeritics service representative using the Service Test Mode 
(refer to Service Test Mode, page 8-19).

Each dialog has the following push buttons:

Set Lower Piston Home

Zeroes and sets the position of the lower piston, the Set Lower Piston Home dialog is displayed.

If the Master switch on the rear panel is turned off, the position of the lower piston is reset (indi-
cated on the instrument schematic). Use this command to establish the home position before 
operating the analyzer.

Start Starts the calibration procedure. 

Cancel Cancels the procedure; all components return to a ready 
state. 
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Upper Zero Force

Zeroes the force of the upper piston. Be sure the upper piston is raised to its uppermost position 
before beginning.

Zero Height

Zeroes the piston height.  

Lower Force Scale

Scales the lower load cell reading.
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Normalization

This option enables you to view detailed reference run data. The current reference sample analy-
ses are compared to the original “master” reference analysis averages to determine by how much 
the current analysis has shifted from that average. The normalization routine calculates a set of 
polynomials to correct for that difference. What is shown in the Normalization window (see 
example below) is how well the software was able to determine the polynomials it will use to 
correct, or normalize, the collected data.

Include Last Choose the number of recent reference analyses you wish to 
include in the normalization.

Reference Analyses table Lists details of the files chosen in the Include Last field.

Data graphs Displays the Regression fit residuals for the Geometric Mean 
and Applied Pressure in the respective window.

Regression Determines how the Normalization regression is calculated. 

Include Origin Include the origin (0) in the calculation. 

Degree Displays the degree of normalization.
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7.  REPORTS MENU

The commands on the Reports menu enable you to: 

• start, close, and open reports
• specify SPC report options
• generate SPC reports

This chapter also provides information on the tools available for customizing and manipulating 
onscreen reports

Reports can be generated for data collected on a sample that has completed analysis, or on one 
that is currently being analyzed (includes only data collected up to the time of the report).

Description

Listed below are brief descriptions of the commands contained on the Reports menu. Detailed 
descriptions are in subsequent sections.

Start Report Generate a report on a completed sample analysis or on the data 
collected thus far for an analysis in progress. Page 7-2.

Close Reports Close all open report windows. Page 7-4.

Open Report Open a report that was saved from the report window. Page 7-4.

SPC Report Options Specify sample data to include in SPC reports. Page 7-5.

Regression Report Generate a regression report. Page 7-6.

Control Chart Generate a control chart report. Page 7-9.
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Start Report

Select this option to generate a report on a sample analysis; the Start Report dialog is displayed.

File name Displays the name of the sample file you select from the Files 
list window. If you have a sample file open, its name defaults 
to this field. 

• If you select multiple files, the reports specified in each 
sample file are printed to the output destination. 

• If you choose a single file, the Select Reports dialog con-
taining the available reports is displayed. This dialog al-
lows you to select the reports you wish to generate. 
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Status This drop-down list determines the type of sample files that 
display in the Files list window, and within the date range. 
Refer to Table 2-2. File Status and Description, page 2-11 
for a definition of the status types.

Date Range Displays the Select Dates dialog so that you may specify a 
range of dates. Refer to Selecting Files, page 2-10 for a 
description of this push button.

Copies Enabled when the Printer destination is chosen, allowing you 
to print up to four copies of the selected report(s).

Destination Displays a drop-down list of output destinations: 

Printer: reports are generated to your default printer. 

Screen: reports are displayed onscreen

File: tabular reports are converted to a text file which can be 
viewed with a text editor or other text file manipulation tool. 

File name Enabled when you select File as the destination. Allows you to 
enter a name, or you may accept the default.

Files list window Displays a list of the available sample files for the choice 
shown in the Status field and within the range of dates 
specified in the Select Dates dialog.

Directories Displays a list of available drives and directories. The drive 
and directory last accessed is displayed immediately above the 
Directories list window. Refer to page 2-12 for information on 
navigating to other directories. 
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Close Reports

This option enables you to close all open report windows at one time. This avoids having to 
select Close on each report window. This option is unavailable if reports are being generated.

Open Report

This option enables you to open a report that was saved from the Report window; the Report 
window opens with an Open dialog positioned on top. 

Navigate to the desired directory, select your file, and click Open; your saved report is displayed 
in the Report window.
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SPC Report Options

The SPC Report Options dialog lists the variables available for SPC reporting. You can check as 
many as you wish; however, for efficiency, it is best to select only the variables you actually 
intend to use. All variables selected must be computed for each sample file used in an SPC 
report.

If you select an option that requires an entry, the adjacent field is enabled allowing you to enter 
a value.
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Regression Report

The regression report is used to determine the interdependency between two variables. Up to 
three dependent variables (Y-axis) may be plotted against a single independent variable (X-
axis). The degree of correlation between the variables also is reported.

Show report title Select this option to have a title display on your report. You can 
enter up to 40 alphanumeric characters. 

Show graphic Displays a graphic above the report title. For example, you may 
wish to display your company logo. The graphic must be a 
bitmap (bmp) or enhanced metafile (emf).

Click Browse to choose the file; use the Height and Width 
fields to specify a size. This image can be edited or removed in 
the report window if printed to the screen.

X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. Click on 
the down arrow to display a list of variables. The variables in 
this list are the ones you specified in the SPC report options.

With this option, you can plot the regression of up to three Y-
axis variables against the X-axis variable. The X-axis specifies 
the independent variable for the regression, while the Y-axes 
provide the dependent variables.
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Axis Range Specify the beginning and ending values for the X- and Y-axis 
ranges. Data collected outside these ranges are not included in 
the plot. These fields are disabled if you choose Autoscale.

Autoscale Scales the X- and/or Y-axis automatically. 

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report Options 
are included in the new report; however, it does lengthen the 
time required to generate the report.

Tabular report Generate tabular, as well as graphical, data of the included 
samples. A tabular report contains the numeric values 
contributed by each sample.

Label data Allows you to label the points on the plot to correspond with the 
values in the sample files.

Samples Displays the Regression Report Sample Selection dialog, so you 
can choose the sample files to be reported.

File name Use this field to limit the files displayed in the Available Files 
pane. For example; enter g*.smp to display only the files 
beginning with a g.
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Status Determines the type of sample files that display in the 
Available Files pane in the selected directory for all dates, or 
within the specified range of dates. Refer to Table 2-2. File 
Status and Description, page 2-11 for an explanation of the 
Status types.

Date Range Displays the Select Dates dialog so that you can specify a range 
of dates. Refer to Selecting Files, page 2-10 for an explanation 
of this push button.

Use all files in
this directory

Includes all files in the selected directory (listed in the Available 
Files window) in the report.

Directories Lists the current directory. Use the directory window to 
navigate to a different directory. Refer to Selecting Files, page 
2-12 for information on selecting different directories.

Add Moves the selected file in the Available Files pane to the 
Selected Files pane. Alternatively, you can simply double-click 
on the desired files. You can select multiple files by holding 
down Ctrl while making your selections. You can include up to 
200 sample files.

Remove Removes the selected file from the Selected Files pane and 
places it back into the Available Files pane.

Save As Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output 
criteria.

The Copies field is enabled when you choose Printer as the 
destination, enabling you to print up to four copies of the 
report.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a statistic.

Show report title Select this option to include a title on your report. You can 
enter up to 40 alphanumeric characters.

Show graphic Displays a graphic above the report title. For example, you may 
wish to display your company logo. The graphic must be a bit-
map (bmp) or enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited or 
removed in the report window.

X-axis Order By Enables you to choose the order in which X-axis statistics are 
placed.

Time places the files on the graph at numerical points in the 
order of the date/time the files are analyzed.

File name places the files on the graph at numerical points in 
alphanumeric order.
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X-axis Order By
(continued)

Date places the files on the graph at points representing the 
actual date/time the files are analyzed.

Minutes places the files on the graph at points representing the 
minutes that have elapsed from the first file placed on the list, 
which is the earliest-analyzed file.

Days places the files on the graph at points representing the 
number of days that have elapsed from the first file placed on 
the list, which the earliest-analyzed file.

Graph [n] Displays the Control Chart Graph [n] Options dialog, allowing 
you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected on the 
SPC Report Options dialog. The variable you choose will be 
plotted against the variable chosen for the X-axis.

Autoscale Scales the Y-axis scaled automatically. If you wish to specify a 
range, deselect this option and enter a range in the From and To 
fields.

Center Line Displays placement options for the variable’s optional value. 
Choose Entered to specify placement of the line.
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Limit Lines Displays the options available for limiting lines. You can have 
the lines placed at some multiple of the standard deviation or at 
specified positions (Entered).

When you select Entered, the High limit and Low limit fields 
are enabled, allowing you to enter appropriate values.

Tabular report Generates tabular, as well as graphical, data of the included 
samples. A tabular report contains the numeric values 
contributed by each sample.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalculated. 
This ensures that any changes made to the SPC Report Options 
are included in the new report. It also lengthens the time 
required to generate the report.

Samples Displays the Control Chart Sample Selection dialog, for you to 
choose the sample files to report. 

This dialog functions in the same manner as the Regression 
Report Sample Selection Dialog explained earlier in this 
chapter. Refer to page 7-6 if you need assistance on the fields of 
this dialog.
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Save as Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose output 
criteria.

The Copies field is enabled when you choose Printer as the 
destination, enabling you to print up to four copies of the report.

Report Generates the report.
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Printed Reports

Header

All reports contain a header displaying file statistics, such as sample information, instrument 
serial number, date and time of analysis, analysis conditions, and so forth. Headers also contain 
notes of any changes to the sample file that occur after analysis.

Summary reports also contain parameters for the blank analysis when requested.

Compaction reports also contain the calculated parameters of the applicable equation as well as 
the RMS error.   

This example shows a typical report header.
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Onscreen Reports

The report window containing onscreen reports provides many options for customizing and 
manipulating reports: 

• a tool bar, page 7-15
• shortcut menus, page 7-18
• zoom feature, page 7-22
• axis cross hairs, page 7-23

Reports printed to the screen are displayed in a window like the one shown below. Each 
requested report is listed in the Reports window on the tool bar; they are also indicated by select-
able tabs across the top of the report header. To view a specific report, select its tab or select the 
report in the Reports window and click Show.

You can resize the header pane or the data pane using the double arrow obtained when placing 
your cursor at the bottom of the bar separating the two panes. This allows you to “hide” the 
header if desired.

Scroll bars are provided on both panes for scrolling through pane contents.

You can double-click on a report in the list to display the contents of that report.

Tabs display for each type of report you choose to generate.

Options on 
Tool Bar

List of 
reports 
requested

Header

Display graphical 
(or tabular) data

Resize the 
panes

Scroll bars are provided on each pane to 
scroll pane contents
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Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the report has 
been hidden, it and its associated tab will become visible.

Delete Deletes the selected report. The deleted report(s) will have to be 
regenerated if deleted in error.

Hide Hides (removes) the selected report from the report window. 
The report’s associated tab is also removed. 

Open Opens a previously saved report file.

Print Displays a print dialog so that you can choose a printer for 
report output. A list of available reports is displayed in the 
window on the right side of the dialog. 
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For convenience in selecting the reports to print, push buttons 
are provided beneath the report window. Or, you can make your 
selection by clicking on the desired reports.  

Current prints the report displayed in the report window.

Shown prints only the shown reports; any nonhighlighted 
reports indicate they are hidden. You can still select hidden 
reports from this window to print.

All prints all reports, including those that may have been 
hidden.

Clear clears all selections.

Save Saves all reports of the currently open file in a report format 
using the same name as the sample file, only with an rep 
extension. If you wish to specify a name and/or specific reports 
to save, use the Save As push button.
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Save As Saves all or specified reports from the currently open file. The 
push buttons displayed on this dialog perform in the same 
manner as the print dialog (explained above).

Reports can be saved in three different formats:

Report system (*.rep): Saved in a format which allows you to 
open the file using the push button on the Report window tool 
bar, or from the Reports > Open Report command.

Spreadsheet (*.xls): Saved in a format which can be imported 
into most spreadsheet programs.

Ascii Text (*.txt): Saved in ASCII text which can be imported 
into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can specify default 
parameters for report fonts and curve properties.

Font Contains a list of report elements for which the font can be 
edited. Highlight the element and click Edit to specify font 
attributes.

Curve Specify a thickness for report curves.

Graph border
line thickness

Specify a thickness for the border of the graph.

Load Load the last saved defaults.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a report.

Tabular Reports

Save Saves the changes as the defaults. If you do not click Save, the 
changes apply to the current report set only. The next reports  
revert to the defaults.

Close Closes the Default Style dialog and applies the changes. If you 
clicked Save, the changes become the defaults. If you did not 
click Save, the changes apply only to the current report set. 

Close Closes the report window.

Resize column Specify the width of the selected column (in inches).

Rename column Edit the name of the selected column. Use Ctrl + Enter to insert 
line feeds.

Move column Move the location of the selected column to the left or to the 
right.

Align column Enables you to right-align, left-align, or center the data in the 
selected column.
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Graphs

Hide column Displays a list of all columns that are not hidden, enabling you 
to select the one you wish to hide.

Show column Displays a list of hidden columns, enabling you to have them 
shown again.

Column font Change font attributes for the tabular data in the current report. 

Header font Change font attributes for column headers in the current report.

Edit title Edit the table title and font.

Copy table as text Copy the entire table (column headers and data) and insert it 
into another program. Columns are tab-delimited, allowing easy 
alignment.

Autoscale Autoscales all axes of the graph. This function is useful for 
returning to a full view after zooming.

Redraw Sets axis boundaries to its original view. You can also use this 
function to remove cross-hairs.

Show curve Show a hidden curve. This option is disabled (greyed) if no 
curves have been hidden.

Hide curve Hides a curve.
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Edit curve Allows you to edit curve properties.

Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data can be 
displayed.

Choices: Curve, Histogram, Points, Curve and Points

Curve group box Edit the curve interpolation, the style of curve and/or points, 
and the pen color. The options in this group box are disabled if 
Histogram is chosen in the Style drop-down list.

Histogram group
box 

Allows you to specify the type of fill and the color if Histogram 
is chosen as the style for collected data.
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Edit axis Displays the Axis Properties dialog, allowing you to edit axis 
properties.

Edit legend Displays the Legend Properties dialog, allowing you to edit the 
placement of the legend.

Edit title Displays the Title Properties dialog, allowing you to edit the 
current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing you to 
paste it into other applications accepting Windows metafiles. 

Copy as text Copies the data used to generate the graph as a series of tab-
delimited columns of text.

Select this 
option to 
remove the 
legend.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
details. To use this feature, hold down the left mouse button and drag the mouse cursor (drawing 
a box) across the area you wish to view; then release the button. The enlarged area immediately 
fills the graph area. Right-click in the graph area and choose Redraw or Autoscale from the 
shortcut menu to return to the normal view.
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Axis Cross Hair

A cross-hair function is available so that you can view axis coordinates. To use this feature, sim-
ply left-click in the desired area of the graph.

Right-click in the graph area and choose Redraw or Autoscale from the shortcut menu to 
remove cross-hair lines and return to the normal view. Alternatively, you can click outside of the 
graph area.
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8.  OPTIONS MENU

The Options menu contains commands that allow you to configure the system to your labora-
tory’s requirements, and to access service tests. With the options on this menu, you can:

• Choose between basic, advanced, or restricted mode 
• Edit program defaults 
• Specify data presentation modes
• Specify a directory for predefined parameter files
• Access the service test mode to perform calibrations

Description

Option Presentation Allows you to display the sample file dialog in Advanced, 
Basic, or Restricted format. Page 8-3.

Sample Defaults Specify defaults for the parameters contained in the sample 
information and parameter files. Page 8-6.

Reference Table Specifies the void volume range for SRB (Standard Reference 
Black) reference materials for the carbon industry. Page 8-13. 

User Models Enables you to enter calculated parameters, such as alternate 
COAN, from void volume curves based on your own 
experimentation. Page 8-14.



Description DVVA II 4000

8-2                                                    400-42803-01 (Rev B) - July 2017

Units Choose the types of units to use for measurement, pressure, and 
temperature. Page 8-13.

Graph Grid Lines Choose the types of grid lines to display for the X- and Y-axes. 
Page 8-13.

Live Graph Choose the variable for the X-axis during data collection. 
Page 8-18.

Parameter Files Directory Specify a different location for the predefined parameter files 
used by the Basic and Restricted formats. Page 8-19.

Service Test Mode Enables you to perform certain troubleshooting procedures. 
This option is available only under the direction of a 
Micromeritics service representative. Page 8-19.
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Option Presentation

The sample information dialogs for the DVVA II program can be presented in an Advanced, 
Basic, or Restricted format.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. Click 
the tab (or use Next and Prev) to access the parameters. 

The Advanced format is used to create customized sample files. You can also switch to the Basic 
format, if desired, by clicking Basic. Refer to Advanced, page 5-4 for a detailed description of 
this dialog.
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Basic

The Basic format presents the sample information file and its parameter files in a single dialog. 

This format is used to create sample information files using previously defined parameter files. 
You can easily switch to the Advanced format by clicking Advanced. Refer to Basic, page 5-7 
for a detailed description of this dialog.
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Restricted

The Restricted format is identical to the Basic format, except that certain menu options are dis-
abled, and you cannot switch to the Advanced format. 

This format is password-protected and typically is used in laboratories where analysis conditions 
must remain constant.

When you select Restricted, a dialog requesting a password is displayed:

Any password (up to 31 characters) can be used to enable the Restricted format. The same pass-
word must be used to exit the Restricted format. For example, if you enter “password” to enable 
the Restricted format, then you must use “password” to exit. If you forget the password, open the 
WIN4000.INI file and navigate to the Private section. The current password will be shown 
immediately following “OptionPresentationPassword.” Make a note of the password, exit the 
WIN4000.INI file, and enter the password where requested. Do not attempt to delete the pass-
word in the WIN4000.INI file.

Does not contain an 
Advanced push button allow-
ing access to all parameters 
of the file.
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Sample Defaults

This option allows you to specify default parameters for sample information files. You can spec-
ify defaults using the Advanced or Basic formats only. The defaults specified for the Basic 
format are used for the Restricted format. 

Advanced

The Advanced Sample Defaults dialog contains tabs for each parameter. The values you specify 
in the parameter portions (Analysis Conditions and Report Options) of the sample file are saved 
as the defaults for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, then click Yes to create the file, and the 
defaults you specify display for all parameters.

• Select File > Open > Analysis Conditions, name and create the file, and the defaults you 
specify in the Analysis Conditions portion of the Advanced Sample Defaults dialog 
display in the fields.
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Sequence Specify a default sequence for the sample file name. The 
number you specify is sequenced incrementally each time you 
create a sample file and is the one that appears in the File name 
field when you select File > Open > Sample Information.

• Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included.

• Use up to eight characters

• The application prohibits using such characters as * or ?

Sample Enter an additional identification that provides more 
information than the sample file name alone.

In the field on the left: edit the prompt for Sample if desired. 
For example, you may prefer to use Test or Material. You can 
use up to 20 characters.

In the field on the right: specify a format for the sample identi-
fication. Or, leave this field blank and enter identifications as 
files are created.

• Use numbers, letters, or other printable characters, such as 
dashes

• Use up to 42 characters (including the $ symbol if used)

• Include the automatically generated file name as part of the 
identification by using the $ symbol where you want the 
sequence number to appear.

For example, if the sequence number is 000-001, enter the 
sample identification as follows:

 Lab #25 - $

The resulting sample identification for the first sample infor-
mation file would be:

 Lab #25 - 000-001

and the second:

  Lab #25 - 000-002, and so on.
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Operator
Submitter

Enter the name (or other identification) of the operator 
performing the analysis and the name of the person, department, 
customer, etc. that submitted the sample for analysis.

The fields on the left can be edited to display something other 
than Operator and Submitter if desired. You can use up to 20 
characters in each field.

The fields on the right are used to specify default names or 
titles, or leave them blank and enter names when the files are 
created.

• Include the automatically generated file name (number) by 
using the symbol $ where you want the sequence number to 
appear. Refer to the example given above.

• Use up to 42 characters (including the $ symbol)

• Select Omit to prevent this item from displaying on the sam-
ple file dialog

Bar Code This field enables you to enter bar code information. If bar code 
information is not used, you can use this field to enter additional 
information about the sample; for example, you may wish to 
enter the lot number of your sample.

This field, as well as other fields on the dialog, accepts data 
from a bar code reader. A bar code reader can be attached to one 
of the USB connectors on the computer. Simply scan the bar 
code and the number transfers to the highlighted field.

Range: 40 alphanumeric characters

The label for this field may be customized to display differently 
or omitted from displaying at all using the options available in 
Sample Defaults, page 8-6.

Mass Enter a default value for the sample’s mass; 1.0000 gram, ± 0.05 
(determined to nearest 0.0001 gram) is the recommended 
amount of sample to use.

Skeletal Density Enter the skeletal density (also known as the true density) of 
your most commonly analyzed sample.
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Bulk Density Enter the bulk density of your most commonly analyzed 
sample.

User Parameters The fields in this group box can be used for SPC (Statistical 
Process Control) reporting. They are used to specify character-
istics of the sample or its manufacturing process, as well as to 
enter constants to be included in User Model formulae.

Once specified, these parameters display on the sample editor 
and in the SPC Sample Options dialog.

These fields can also be used to record analysis conditions or 
sample information so that it can be printed on the Summary 
report.

Select Omit to prevent them from displaying on the sample 
information dialog.

Material Properties Enter the type of sample material you are analyzing.The 
Material type is used to determine which carbon property 
models are used for this particular carbon. For example, a 
different equation is used to predict COAN for Tread/Hard 
carbons than for Carcass/Soft carbons. If you select Other, the 
COAN is not calculated. 

Choose Other only when your material is something other than 
Tread/Hard or Carcass/Soft.

Comments Enter comments about the sample or its analysis conditions. 
Comments entered here are printed in the header of the reports.

Add Log Entry Displays the Add Log Entry dialog, enabling you to enter 
comments about the sample or its analysis conditions.

Anything you enter using this option appears in the Sample 
Log; it does not display in the report header.
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Click on each remaining tab of the Advanced Sample dialog to establish parameter defaults. 
Refer to the sections indicated below if you need assistance on the fields of the dialogs.

• Analysis Conditions, page 5-10
• Report Options, page 5-12

Basic

The dialog for the Basic format contains all parameters on one screen. 

The defaults you specify for the Basic format also serve as the defaults for the Restricted format.

Replace All Replace the contents of all parameters in the current default 
sample file with those from an existing sample file. For 
example, you may have an existing sample file that contains the 
parameters that you wish to use for defaults.  
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Sequence Specify a default sequence for the sample file name. The 
number you specify is sequenced incrementally each time you 
create a sample fileand is the one that appears in the File name 
field when you select File > Open > Sample Information.

• Use numbers, letters, or other printable characters, such as 
dashes. At least three numbers must be included

• Use up to eight characters

• The application prohibits using such characters as * or ?

Sample Enter an additional identification that provides more 
information than the sample file name alone.

In the field on the left, edit the prompt if desired. For example, 
you may prefer to use Test or Material. The maximum number 
of characters is 20.

In the field on the right, specify a format for the sample 
identification.

• Use numbers, letters, or other printable characters, such as 
dashes.

• Use up to 42 characters (including the $ symbol if used)

• Include the automatically generated file name as part of the 
identification by using the $ symbol where you want the 
sequence number to appear.

For example, if the sequence number is 000-001, enter the 
sample identification as follows:

       Lab #25 - $

The resulting sample identification for the first sample infor-
mation file would be:

       Lab #25 - 000-001

and the second:

       Lab #25 - 000-002, and so on.
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Analysis Conditions
Report Options

Each parameter has a drop-down list containing predefined 
parameter files (some were included with the software). Choose 
the file you wish to use as the default.

Mass Enter a default value for the sample mass; 1.0000 gram, ± 0.05 
(determined to nearest 0.0001 gram) is the recommended 
amount of sample to use.

Skeletal Density Enter the skeletal density (also known as the true density) of 
your most commonly analyzed sample.

Bulk Density Enter the bulk density of your most commonly analyzed 
sample.

Material Properties Choose the type of sample material you are analyzing. The 
Material type is used to determine which carbon property 
models are used for this particular carbon. For example, a 
different equation is used to predict COAN for Tread/Hard 
carbons than for Carcass/Soft carbons. If you select Other, the 
COAN is not calculated. 

Choose Other only when your material is something other than 
Tread/Hard or Carcass/Soft.

Scan Rate
Ending Pressure
Recording
Use Prior Blank
Measure Residual Volume
Time Between Cycles

Displays the values and options specified in the Analysis 
Conditions file you choose for the default.

Selected Reports Displays the reports selected in the Report Options file you 
choose for the default. 

Replace All Replace the contents of all parameters in the current default 
sample file with those from an existing sample file. For 
example, you may have an existing sample file that contains the 
parameters that you wish to use for defaults. 

Save Saves the specified defaults.

Close Closes the dialog.
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Reference Table

This table lists the void volume range for SRB (Standard Reference Black) reference materials 
for the carbon industry.

Reference Name Contains the SRB reference number or name.

Class Indicates the type of reference material; Tread/Hard or 
Carcass/Soft.

Void Volume Displays the void volume range.

Insert Allows you to add reference materials to the list of defaults.

Click the down arrow at the end of the field to display a list of 
reference materials. 

Delete Removes the selected reference material from the list. You can 
add it back to the list using the Insert button. 
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User Models

Enables you to enter calculated parameters, such as alternate COAN, from void volume curves 
based on your own experimentation. The calculation results will appear on the Summary Report 
when selected.     

Material Displays the type of material.

Model Name Displays the name of the model.

Formula  Displays the formula to be used for the model.

Insert Displays the Model Table Edit dialog.

Material Enter the name of material to be associated with this model.
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Name Enter a name for the model.

Formula  Enter a formula for the model. The formula can contain any of the 
following: 

  +, -, /, *, ^,
  parentheses are allowed,
  numeric constants.

  Math functions:
     exp (natural exponential, not base 10)
     log (natural log, not base 10)

Note the capitalization in the following variables. The variables 
must be entered with letters capitalized as shown below. Also note 
there are related functions that vary only in whether they use an 
applied or a geometric mean pressure as the argument. For 
functions that take an applied pressure, two identical forms are 
provided (e.g., Height and HeightA).

Collected data functions:
    Height(applied pressure in MPa) (cm)     
    HeightA(applied pressure in MPa) (cm) 
    HeightM(geometric mean pressure in MPa) (cm) 
    Work(applied pressure in MPa) (cm3/g)
    WorkA(applied pressure in MPa) (cm3/g) 
    WorkM(geometric mean pressure in MPa) (cm3/g) 
    VV(applied pressure in MPa) (cm/Newton) 
    VVA(applied pressure in MPa) (cm/Newton) 
    VVM(geometric mean pressure in MPa) (cm/Newton)
     dHdF(applied pressure in MPa)
     dHdFA(applied pressure in MPa)
     dVdP(applied pressure in MPa)
     dVdPA(applied pressure in MPa)
     dHdFM(applied pressure)(cm)
     dVdPM(applied pressure)(cm3) 
    ApparentDensity(applied pressure in MPa) (g/cm3/g)
    ApparentDensityA(applied pressure in MPa) (g/cm3/g)
    ApparentDensityM(geometric mean pressure in MPa) (g/cm3/g)
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Formula  Collected constants:
      Mass (g)
      Piston Area (cm2)
      TopOfSample (cm)
      BulkDensity
      ResidV (cm3, residual void volume)
      ResidH (cm, residual top-of-sample)
      WorkPressureSlope (Newton-m/g/MPA, applied pressure) 
      WorkPressureSlopeA (Newton-m/g/MPA, applied
          pressure)
      WorkPressureSlopeM (Newton-m/g/MPA, geometric mean
          pressure)
      User Parameters*

*The user parameters on the Sample Information dialog (refer to 
User Parameters, page 5-5) can be used in the formula as well. 
The names of the user parameters must match the ones specified in 
the sample default file.

When entering a formula, you can enter constants with the names 
of the user parameters defined in the sample defaults file (refer to 
Sample Defaults, page 8-6).

When calculating the value for the formula, the software will look 
up the user parameter with that name in the sample file. If it does 
not exist, then the formula will not be evaluated.

Units Enter the units in which the calculation results will be expressed.

Precision Enter the number of decimal places to be included in the  
calculation results.

Edit Enables you to edit the selected model.

Delete Deletes the selected model.

Clear Clears all entries from the table except one; one is required.
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Units

Choose the manner in which to display pressure, force, and length; the Units Selections dialog is 
displayed. 
 

Load from File Displays the Select User Model File dialog, allowing you to load a 
model file saved in text (.txt) format.

Save to File Save the selected model to a text file. Refer to the dialog shown 
above.
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Graph Grid Lines

Choose the type(s) of grid lines to show on your reports; the Graph Grid Lines dialog is 
displayed. 

Live Graph

This option enables you to change the view of the graph during data collection. You can change 
the x-axis to scale data on a Linear Scale or Logarithmic Scale.

X-Axis
Y-Axis

Choose Major and/or Minor lines to display in printed 
reports for the Logarithmic and Linear scales. 

Grid lines are not shown if these items are not selected.

Grid Line Style Choose the type of grid line to display.
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Parameter Files Directory

Edit the location for predefined parameter files displayed in the drop-down lists on the Basic and 
Restricted Sample Information dialogs. The current directory specified for parameter files is dis-
played above the directory window. 

The directory specified here is the one you should use when creating parameter files to be 
included in the drop-down lists on the Basic and Restricted sample information dialogs. The 
default directory is param and includes several parameter files supplied with the analysis pro-
gram. If you specify a different directory, these files will not be included in the drop-down lists 
unless you copy (or move) them to the new directory.

If you wish to continue to use the param directory for parameter files, it displays as the default 
when saving parameter files.

Service Test Mode

Calibration procedures are included in the DVVA II 4000 operating program. Some of these cal-
ibrations can be performed only with the assistance of a trained Micromeritics service 
representative. When you select Options > Service Test Mode, a dialog prompting you to enter 
a password is displayed. This password is coded to change on a regular basis and will be pro-
vided by your service representative. 



                                            



DVVA II 4000 Troubleshooting

400-42803-01 (Rev B) - July 2017                                              9-1 

9.  TROUBLESHOOTING AND MAINTENANCE

This chapter describes common operational problems and their solutions, and maintenance pro-
cedures. If further assistance is needed after following the procedures in this chapter, contact a 
Micromeritics Service Representative.

Troubleshooting

Operating problems encountered with the DVVA analyzer are usually easily corrected. Typical 
problems and the steps required to correct them are described in the following table.

Table 9-1. Common Operational Problems

Problem Cause Solution

Fault indicator will not turn 
off

Safety shield is not completely 
closed.

Slide the safety shield all the 
way down.

Drawer is open. Close the drawer.

The Emergency Stop button is 
engaged.

Turn the Emergency Stop 
button to the right to release it, 
then press Reset.

The USB cable was discon-
nected and reconnected while 
the analyzer was on.

Turn the analyzer on after the 
USB cable has been connected.

Application is not operating. Start the application.

The Windows program has 
closed unexpectedly.

Restart the computer, turn on 
the analyzer, and restart the 
application.

Emergency Stop               Reset
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Problem Cause Solution

Inconsistent results when 
conditioning the tip

Different amounts of the 
sample were used.

Use 1.0000 gram, ± 0.05 
(determined to nearest 0.0001 
gram) of sample for each 
analysis.

The same type of sample was 
not used for all analyses.

Use the same type of sample 
for all analyses.

All samples were not prepared 
in the same manner.

Use the same preparation 
method for all samples.

The piston tip is not securely 
affixed to the piston.

Moderately tighten the tip 
using a 3/8-in. wrench.

The upper or lower piston tip is 
dirty.

Wipe the piston tips with a 
Kimwipe or paper towel 
between each blank analysis 
and each sample analysis.

The piston tip is damaged. Replace with a new tip and 
perform the conditioning 
procedure.

Not enough sample runs have  
been performed.

Perform additional sample 
runs.
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Problem Cause Solution

Lower piston motor reports 
errors

The sample is exerting a high 
residual force on the lower 
piston after sample 
compaction.

Use the provided pellet 
removal tool to break up the 
compacted sample in the 
sample chamber, then manually 
lower the lower piston to the 
tray-loading position. Refer to 
“Lower Piston Release 
Procedure” on page 9-8.

The lower piston tip is not 
securely affixed to the lower 
piston in the sample tray.

Moderately tighten the lower 
piston tip.

The lower piston tip is worn or 
damaged.

Replace with a new tip.

The wrong tray is inserted in 
the analyzer.

Insert the correct tray.

Readings in the instrument 
schematic display all zeros.

The DVAA II 4000 was not 
recognized by Windows, 
preventing the data acquisition 
drivers from loading.

Perform “Full Power-On 
Procedure” on page 9-4.

Piston will not move Manual control is not enabled Select Unit > Enable manual 
control.

You forgot to press Reset. Press Reset.

One of the piston circuit 
breakers has tripped.

Wait a few minutes and reset 
the breaker.

The opposing piston is not in 
the proper position.

Select Unit > Enable manual 
control and move the piston to 
the proper position.



Troubleshooting DVVA II 4000

9-4                                                    400-42803-01 (Rev B) - July 2017

Full Power-On Procedure

The power-on procedure is to be performed after the instrument has been shut down for an 
extended period of time or after a loss of power.

1. Make sure the instrument and computer are in the following state before continuing:

a.  Computer is turned OFF.

b.  The instrument MAIN POWER switch (on back panel) is in the OFF position.

c.  The instrument Power switch on the front panel is in the OFF position.

d.  The USB cable is disconnected from the instrument.

2. Place the instrument MAIN POWER switch on the back panel to the ON position.

3. Connect the USB cable to the instrument.

4. Turn on the computer.  

5. If required, allow Windows to install the drivers for any new hardware found. Refer to 
“Power-On Troubleshooting” on page 9-6.

6. Place the instrument front panel Power switch in the ON position.

7. Start the DVVA II 4000 software.
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8. Display the instrument schematic and ensure that all readings show valid values. If all are 
displaying 0.0, refer to “Power-On Troubleshooting” on page 9-6.

9. Select Calibration > Set Lower Piston Home..., and press the Start button.

Full Power-Off Procedure

This procedure is to be used when the computer needs to be shut down for an extended period of 
time.

1. Exit the DVVA II 4000 software.

2. Place the power switch on the front panel of the instrument in the OFF position.

3. Disconnect the USB cable from the instrument.

4. Place the instrument MAIN POWER switch on the back panel in the OFF position.

Upper load cell

Lower load cells

Linear height transducer

If accessibility to the back panel is a problem, plug the instrument into a power strip 
with an appropriate current rating and use the power strip to turn on the main power. 
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Power-On Troubleshooting

Problem

Computer is connected to the DVVA II 4000 and Windows is trying to update the driver 
software.

Action

Allow Windows to search automatically for the driver software. This will enable Windows to 
install the device drivers that were placed on the computer during the DVVA II 4000 software 
installation.

Problem

The instrument schematic in the DVVA II 4000 software is showing 0.0 readings (as shown 
below). This is caused by Windows not detecting the USB data acquisition device.

Perform Action 1 below. If this does not correct the problem, follow the Actions below in 
sequence until the instrument is reconnected to the computer.

Action 1

1. Exit the DVVA II 4000 software.

2. Wait a about 10 seconds, then restart the software.
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Action 2

1. Perform the Full Power-Off Procedure described on page 9-5.

2. Exit Windows and shut down the computer.

3. Wait about 10 seconds.

4. Perform the Full Power-On Procedure described on page 9-4.

If Windows detects new hardware but does not automatically load the drivers, perform the device 
driver installation process described under Action on page  9-6.

Verify that the instrument schematic in the DVVA II 4000 software is not showing 0.0 readings 
for the linear height transducer and the upper and lower load cells.

Action 3

1. Perform the Full Power-Off Procedure described on page 9-5.

2. Exit Windows and shut down the computer.

3. Unplug the USB cable at the computer, wait about 10 seconds, and then plug into a different 
port in the computer.

4. Perform the Full Power-On Procedure described on page 9-4. Windows should automatically 
load new drivers due to the new port. If not, perform the device driver installation described 
under Action on page 9-6.

Action 4

1. Perform the Full Power-Off Procedure described on page 9-5.

2. Unplug the instrument power cable.

3. Exit Windows and shut down the computer.

4. Unplug the computer power cable.

5. Leave the cables unplugged overnight.

6. Perform the Full Power-On Procedure described on page 9-4. Before starting the DVVA II 
4000 software, check to see if the drivers are loaded. 
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7. If the data acquisition driver has successfully loaded earlier, then an entry named 
"Micromeritics DVVA" will be shown in the Device Manager window. If the driver has 
failed to load, this entry will be missing.

If this entry is missing, perform the device driver installation process described under 
Action on page 9-6.

Lower Piston Release Procedure

Perform Action 1 below. If this does not correct the problem, perform Action 2.

Action 1 

1. Ensure that the upper piston is in the raised position. If it is not, select Unit 1 > Schematic, 
then Unit 1 > Enable Manual Control to display the Manual Control screen. 

Use the  icon next to the upper piston to raise it to its home position. 

Once the instrument is functioning properly, do not turn off the computer power 
switch or the DVVA MAIN POWER switch located on the rear panel of the instrument. 

The DVVA II 4000 analyzer should not be connected via a USB cable to a computer 
unless the DVAA II 4000 is powered (the MAIN POWER switch on the rear panel is in 
the ON position). 

 
 

Upper piston
manual control
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2. If the safety shield is not already raised, raise it to its upper position. 

3. Retrieve the pellet removal tool (shown below) that was included in the instrument 
accessories kit. 

4. Carefully place the tool into the compression chamber and while applying pressure, rotate 
the tool.
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5. The compressed pellet should begin to break up and the lower load cell force shown in the 
Manual Control window should decline, as shown below. When the lower load cell force has 
fallen to approximately 230 kg (500 lbs.), remove the tool and manually move the lower 
piston downward until it reaches its home position using the  icon.

6. If the lower piston moves to its home position:

a. Close the safety shield.

b. Press the Reset button.

c. Proceed to Step 7.

Lower 
piston
manual control 

Lower load
cell force
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If, after several attempts performing steps 4 and 5, the piston cannot be moved to its home 
position:

a. Close the safety shield.

b. Press the Reset button.

c. Proceed to “Action 2” on page 9-12.

7. Select Unit 1 > Clean System from the main menu to clear the compressed pellet from the 
compression chamber.

8. The DVVA II should now be operational.
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Action 2

If Action 1 does not solve the problem, you can manually release the piston as described below.

1. Support the lower front panel from the bottom and remove the four screws shown in the 
photograph below.

2. Remove the panel and set it aside.

Never override the instrument panel sensor or operate the instrument with the panel 
removed.
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3. Using a 9/16-in. (14 mm) open-ended wrench, release the lower piston as shown below. 

4. Ensure that the expandable cover returns properly to its circular groove.

5. Replace the lower front panel and secure it with the four screws. 

6. Close the safety shield.

7. Press the Reset button on the instrument.

8. Select Unit 1 > Return Lower Position Home from the main menu.

9. Ensure that no foreign debris has fallen into the compression chamber. 

While the expandable cover is removed, ensure that no foreign matter is allowed to 
enter inside the cover. Also, avoid disturbing any grease found on the screw thread.

Be careful when releasing the piston, the internal components could cause injury if 
your hands scrape against them. 
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10. Select Unit 1 > Clean System from the main menu to clear the compressed pellet from the 
compression chamber.

11. The DVVA II should now be operational.
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Maintenance

Cleaning Analyzer and Components

• Use a soap-based detergent to clean the exterior casing of the analyzer.

• For the sample shield; first wipe with a soft cloth to remove particles, then use a household 
window cleaner. 

• Use a paper towel or Kimwipe or paper towel to clean the piston tip; never use a solvent.

• You may use a vacuum cleaner on the sample and waste trays.

Do not use detergent or other cleaners on the moving components of the instrument.

Perform a full power-off procedure before you clean around any of the connectors on 
the rear panel of the instrument (refer to page 9-5). Then perform a full power-on 
procedure to turn the instrument back on (refer to page 9-4).
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Replacing and Conditioning the Piston Tip

The piston tip should be replaced when deemed necessary; and must be conditioned before 
using. 

Replacing the Upper Piston Tip

1. Select Unit 1 > Return Upper Piston Home to move the piston to its uppermost position, 
completely out of the sample chamber.

2. Slide the sample compartment shield to its uppermost position.

3. Place a stiff piece of paper or cardboard over the top of the sample funnel to prevent the 
loosened tip from accidentally falling down into the chamber.

   Upper piston
  home position
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4. Using a 3/8-in. wrench, rotate to the left to loosen and remove the piston.

5. Install a new piston tip. Using the same wrench, moderately tighten the piston tip. 

6. Select Unit 1 > Unit configuration to display the Unit configuration dialog.

7. Click the Reset buttons to reset the Upper Tip Run count to 0 (zero), then click OK to close 
the dialog.
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Replacing the Lower Piston Tip

1. Remove the lower piston tray.

2. Using a 3/8-in. wrench, rotate to the left to loosen and remove the piston in the sample tray.

3. Install a new piston tip. Using the same wrench, moderately tighten the piston tip. 

4. Replace the lower piston tray and press the Reset button on the analyzer.

5. Select Unit 1 > Unit configuration to display the Unit configuration dialog.

6. Click the Reset buttons to reset the Lower Tip Run count to 0 (zero), then click OK to close 
the dialog.
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Conditioning the Piston Tip

A new piston tip should always be conditioned before using. Prepare 10 samples, using 1 gram 
(± 0.001 gram) each of the same material for this procedure.

1. Click Unit 1 > Show Instrument Schematic, then Unit 1 > Enable Manual Control.

2. Move the lower piston to its uppermost position.

3. Right-click on the Speed icon and select Medium.

4. Slide the sample compartment shield down, then press the Reset button.

5. Using the instrument schematic, press and hold down the piston Down arrow until the 
pressure display shows 1000 lbf. or greater.

6. Return the lower piston to its lowest position.

7. Select Unit 1 > Return Upper Piston Home to return the piston to its uppermost position.

8. Select Unit 1 > Enable Manual Control to remove the check mark and disable manual 
control. 

9. Minimize or close the instrument schematic.

Use of certain USB devices or the addition or removal of a USB device during an 
analysis may cause a delay in data acquisition, resulting in a loss of data or the 
cancellation of an analysis. Avoid the use of attached USB devices such as flash 
drives, digital audio players, or cellular phones during an analysis. Additionally avoid 
adding or removing USB devices during an analysis.
 

Piston Down arrow

Speed icon

.
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10. Slide the sample compartment shield up; wipe the piston tip with a Kimwipe or paper towel.

11. Slide the sample compartment shield down; press Reset.

12. Select Unit 1 > Sample Analysis; the Analysis dialog is displayed with the Open Sample 
Information dialog positioned on top.

13. Click OK to accept the next sequenced number in the File name field; the Analysis dialog 
containing file defaults is displayed.

14. Click Replace All and select the file named COND.smp, then click OK.

All appropriate values will be inserted into the dialog fields. 

15. Edit the description in the Sample field by adding a 1 indicating this is the first of 10 
analyses; 10 analyses are performed when conditioning the piston tip.
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16. Enter the sample mass in the Mass field

17. Click Start to begin the analysis; a dialog showing data as collected is displayed.

18. After the blank analysis is complete, a dialog prompting you to add sample is displayed. Do 
not click OK until you have placed the sample in the chamber.

The piston automatically returns to the home position at the completion of the blank analysis.
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19. Slide the sample compartment shield up; wipe the piston tip with a Kimwipe or paper towel.

20. Pour the sample into the sample chamber and close the shield; press Reset.
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21. Click OK on the Load Sample dialog to continue the analysis; a dialog stating No Data 
Available is displayed until analysis data starts to collect, then the following dialog is 
displayed.

The piston automatically returns to the home position when the analysis is finished.

22. Slide the shield up and wipe the piston tip with a Kimwipe or paper towel, then close the 
shield; press Reset.  

23. Click Next on the Data Collection view of the Analysis dialog to return to the first view of 
the Analysis dialog.

24. Click Browse; the Open Sample Information dialog is displayed.

25. Click OK to accept the next sequenced number in the File name field; the Analysis dialog 
containing file defaults is displayed.

This button 
changes to 

 when the analy-
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26. Enter the correct mass for the sample being analyzed.

27. Repeat steps 13 through 24 for the remaining nine samples. Be sure to:

• change the Sample identification sequentially
• wipe the piston tip after each blank analysis and sample analysis

28. Advance to Overlaying Results to determine if the piston is sufficiently conditioned.

Overlaying Results

When results start to be consistent, the piston tip is sufficiently conditioned. Perform the follow-
ing steps to overlay the results from the last six analyses:

1. Select File > Open Sample Information and choose the fifth file of the condition series.

2. Click the Report Options tab to display the Report Options dialog.
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3. Highlight Height vs Pressure Appl and click Edit; the Height vs. Pressure Trend Plot dialog 
is displayed.

4. Click the down arrow to the right of the Overlay field and choose Overlay Samples, then 
click OK to return to the Report Options dialog.

5. Click Overlays on the Report Options dialog; the Graph Overlay dialog is displayed.

6. Click Browse to the right of the first five Sample [n] fields and select the remaining files 
used in the conditioning procedure.

7. Click OK to return to the Report Options dialog.

8. Click Save on the Report Options dialog; do not close the dialog.

9. Click Reports > Start Report; the Start Report dialog is displayed. Note that the number of 
your open file defaults to the File name field. 

10. Be sure the destination is set at Screen, then click OK; the Selected Reports dialog is 
displayed. 

Click the down arrow 
and choose Overlay 
Samples.
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11. Click OK; the report window containing overlay results is displayed. Click the Height vs 
Pressure tab to display the data.

12. Right-click in the graph area and choose Autoscale from the shortcut menu.

13. Zoom in on these portions of the graph: 5,000, 15,000 and 25,000 psi. Continue zooming on 
each until you can determine if the curves for three sequential runs are within 0.001 inch.

If the curves are not within this range, repeat analyses until three sequential curves are 
obtained. If after a total of 20 analyses you still have not obtained these results:

• Refer to Table 9-1. Common Operational Problems, page 9-1 for corrective solutions.

• Contact your service representative if the solutions in Table 9-1 do not correct the 
problem.
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Normalization

The instrument should be normalized with SRB series reference materials on a regular basis to 
compensate for wear on the piston tip. This is accomplished by performing two reference runs on 
each reference material on a monthly basis, or, one run on each reference material two times a 
month. This will consist of 12 runs; two each on the six reference materials.

Two runs each are sufficient for maintaining normalization. When you replace the piston tip, you 
should perform four runs each. This will be a total of 24 runs when a new tip has been installed.

1. Perform two blank analyses as described in steps 1 through 16 under the heading 
“Replacing and Conditioning the Piston Tip” on page 9-16.

2. Prepare two samples of one of the reference materials (prepare according to the instructions 
used for everyday samples, page 3-13).

3. Wipe the piston tip with a Kimwipe or paper towel, close the sample shield, and press Reset.

Do not load the reference material until prompted to do so; a blank run is performed 
first.
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4. Select Unit > Reference Run; the Reference Run dialog is displayed.

5. Enter the sample mass in the Mass field.
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6. Using the table below, enter in the Bulk Density field the bulk density of the reference 
material for this run.

7. Click Start to begin the blank run.

8. When the blank run has finished, the following dialog is displayed:

9. Perform the following steps:

a. Open the sample shield.
b. Pour the reference material into the sample chamber.
c. Wipe the piston tip with a Kimwipe or paper towel.
d. Close the sample shield and press Reset.
e. Click OK on the Load Sample dialog to begin the reference run. 

10. When the analysis has completed, the Start push button on the dialog changes to Next; Click 
Next to return to the original view of the Analysis dialog.

Bulk Density for
SRB Reference Materials

Reference Name Bulk Density

A-8 Tread/Hard 0.41

B-8 Tread/Hard 0.31

C-8 Tread/Hard 0.29

D-8 Carcass/Soft 0.64

E-8 Carcass/Soft 0.44

F-8 Carcass/Soft 0.34
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11. Perform the following steps:

a. Open the sample shield.
b. Wipe the piston tip with a Kimwipe or paper towel.

d. Close the sample shield and press Reset.

12. Complete steps 1 through 10 for all reference materials. 
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Verifying Normalization Results

The current reference sample analyses are compared to the original "master" reference analysis 
averages to determine by how much the current analysis has shifted from that average. The nor-
malization routine calculates a set of polynomials to correct for that difference. What is shown in 
the Normalization window (see example below) is how well the software was able to determine 
the polynomials it will use to correct, or normalize, the collected data.

1. Select Unit > Normalization; the Normalization dialog is displayed.

2. Note the residual values displayed on the dialog.
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10.  ORDERING INFORMATION

Accessories and replacement parts for the DVVA II analyzer can be ordered using one of the fol-
lowing methods: 

• Call our Customer Service Department at (770) 662-3636
• Access our web site at www.micromeritics.com
• Contact your local sales representative

When ordering, please use the information provided below to place your order:

Part Number Item and Description

400-25808-00 Piston tip assembly, 1/2 in.  

004-24046-01 Scale pan, for weighing sample

004-54617-00 Brush, for dusting any remaining sample from the sample container into 
the chamber

004-54010-00 Wrench, 3/8 x 7/16, open end

400-09805-00  Pellet removal tool

400-42813-00 Operator’s manual 
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A.  ERROR MESSAGES

Error messages for the DVVA II program are listed numerically. If the Action response instructs 
you to contact your service representative, record the error message and make backup copies of 
any files involved in the operation.

2200 and 2400 Series

2201- Cannot execute report subsystem.

2401- FATAL ERROR: (error message).

2430- Error accessing file (file name), error code = (number). 

Cause: Start Report failed to execute the report subsystem (which is a separate 
process).

Action: Restart the computer. If the problem persists, reinstall the application 
(this will not affect any of your sample files). If the problem continues, 
contact a Micromeritics service representative.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause A: A computer or network problem occurred.

Action A: Check the performance of your computer devices or network.

Cause B: A software error occurred when the file was accessed.

Action B: Contact your service representative.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI ‘FILE_READ’ request.

2433- New entries have been found in this directory. Refresh the directory information?

2434- File (file name) — Subset # (number) wrote wrong amount of data.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to a diskette, CD, or 
network directory, delete them from the hard disk, and then try the 
operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Several files (sample information or parameter files) have been added 
to this directory by some function other than the DVVA II program.

Action: Select Yes to update the directory information with data from each new 
file. This operation may take a minute.

Select No if you do not want to spend the time updating the directory 
information. This option may be feasible if a large number of files have 
been copied into the directory and you know the name of the file you 
wish to access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2436- Path specification (path name) is invalid.

2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Could not register file.
2440- Subset not found.
2441- Seek within file failed.
2442- Bad header in subset file.
2443- Subset owner denied access.
2444- Not a valid file format.
2445- Subset wrote the wrong amount of data.
2446- Error reading data.
2447- Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension) and press 
Enter. 

Cause: You entered a file specification that does not exist.

Action: Enter an existing file specification or select a file name from the list 
box.

Cause: You entered an invalid path name and/or extension.

Action: Type a valid path name (including the proper extension), and press 
Enter.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to move to the correct directory.
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2449- This field does not contain a valid file specification.

2450- Sample Defaults may not be edited while this operation is in progress. Do you wish 
to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. (file name)
2453- Attempt to append MICATTR.DIR in read only mode. (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) selections 
will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your Windows man-
ual and re-enter the name.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: The Read-Only attribute is turned on in the application’s 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message. 
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2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently displaying 
or printing results.

2458- An instrument is performing a critical operation. Wait a few moments before exiting 
the application.

2459- An instrument is busy. A delay in restarting this application could result in loss of 
new data. Continue with program Exit?

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.

Cause: You attempted to exit the application while the analyzer is performing 
a critical operation. This operation must be completed before the appli-
cation can be stopped.

Action: Wait a few minutes before attempting to exit the application again.

Cause: You attempted to exit the application while the analyzer was perform-
ing an operation.

Action: Rather than exiting the application you may choose to minimize it.
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2460-  Fatal Communications error on (unit nn).

2461- No instruments are in operation. This application will unconditionally terminate.

2480- File (file name) cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file (file name).

Cause: Repeated attempts to maintain communication with the analyzer have 
failed.

Action: Check the communications cable connecting the analyzer to the com-
puter. Confirm that the analyzer is turned on and that the Ready indi-
cator is illuminated. 

If these checks are okay, exit the analysis program and then restart the 
application. If this error persists, contact your service representative.

Cause: The initialization of the analyzer configured with the Set Up program 
has failed. The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer’s failure to initialize. See the instructions for that mes-
sage. 

Action B: Check the cable connection between the analyzer and the computer. 
Verify that the analyzer has the power switch in the ON position and 
that the light on the front panel is illuminated. If the application con-
tinues to fail in its attempts to initialize the analyzer, contact your ser-
vice representative.

Cause: You attempted an analysis using a sample file that is being edited.

Action: Save the changes and close the dialog.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.
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2482- File cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and contains 
errors.

2484- The edit session for (file name) must be saved before the analysis. Save changes 
and continue with the analysis.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.

Cause C:  A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: You are attempting to open a file that is currently being used (either by 
this application or another).   

Action: Locate the application using the file (in the Micromeritics application, 
use the Windows menu item to get a list of all windows, one of which 
may contain this file).

Cause: You attempted to use a sample file containing errors that is currently 
open.

Action: Go to the window containing the file, correct the errors, and save it.

Cause: You attempted an analysis using a sample file that contains unsaved 
changes.

Action: Select Yes to save the changes and continue with the analysis. 

Select No to abort the analysis and return to the sample file.
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2486- Cannot construct (name) report type. Program will terminate.

2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

2489- File (file name) cannot be opened for writing. It is already in use.

2490- No ‘.INI’ file present. Application will terminate.

Cause A: You may not have full rights to the applications’s folders and files.

Cause A: You may not have full rights to the applications’s folders and files.

Action B: An internal processing and/or hardware error has occurred.

Action A: Contact your service representative if you continue to receive this 
error.

Cause: The file you specified is being used in another edit operation.

Action: Check the Windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: The ASCII (.INI) file containing initialization and system options 
information cannot be found. The .INI file may have become cor-
rupted. The application cannot operate without this file.

Action: Use the Set Up CD to uninstall the analysis program. When you unin-
stall the program, only application files are deleted; data files remain 
intact.

After the uninstall operation is complete, reinstall the program.
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2492- This field’s entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.
2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

2499- Sequence number must contain at least 3 digits.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field requires a valid entry for you to proceed.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select an appropriate value.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: You tried to enter a sequence number that did not contain at least three 
digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2500- All sample file names that can be created using the sequence number pattern 
already exist. You may want to modify the next sequence number. 

2501- System resources have reached a dangerously low level. Please close some win-
dows to avoid the loss of data. 

2502- Error writing to file (name) during print. Error code: (number).

2504- Cannot create output file for sample (sample name).

2505- Error Logger cannot be initialized!  Error code (number). Program will exit.

Cause: No more sample information files can be created using the currently 
entered file name sequence number.

Action: Select Options > Sample Defaults from the Main Menu and enter a 
new sequence number.

Cause: A large number of windows is open and consuming the system 
resources available to all applications.

Action: Close one or more windows. Contact your service representative if you 
continue to receive this message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this error message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.
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2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

2510- (sample file) Error parsing reports from file (name). Reports cannot be produced.

Cause: The selected output device is not installed in Windows.

Action: Install the device using the Control Panel > Printers operation.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.
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2511- Print job (name) has been cancelled due to insufficient disk space. Delete unnec-
essary files and restart the report.

2512- Print job (name) has been cancelled.

2513- Unable to read the calibration file (file name).

2514- Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of the 
instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Be sure the media you want to Save the file to has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by, or under the direction 
of, qualified service personnel.
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2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming the controller failed.
2524- CRC check failed on programming controller.
2525- Unknown error programming controller.
2526- Controller download was not successful.

2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: The application has discovered a different version of software operat-
ing in the analyzer. 

Action: If there are no analyzers other than the DVVA connected to the com-
puter, select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.
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2534- Error opening file (name) for printing. Error code: (number).

2547- The instrument is busy. Exiting the application will result in the termination of the 
analysis. Continue with program exit? (Yes, No)

2549- Error accessing online manual file (name).

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: You attempted to exit the application while an analysis is in progress. 

Action: If you are not concerned with cancellation of the analysis, click Yes to 
continue the exit; otherwise select No and allow the analysis to finish.

Cause: You were unable to open the online manual.

Action: Exit the application and reinstall the software. The manual and/or 
reader may have been accidentally deleted. Reinstalling the software 
will reinstall the manual and reader.
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6000 Series

6000- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code n)

6001- Error accessing the sample information file (file name). (Code n).

6002- File (file name) cannot be analyzed. It is currently being edited.

Cause: The control information disk file required by this application could not 
be found.

Action A: The disk drive may have failed or be corrupted. Run diagnostics on the 
disk drive.

Action B: Contact your service representative.

Cause A: You attempted to open a file that is already open, possibly minimized.

Action A: View the minimized icons, locate and maximize the file.

Cause B: A computer or network problem occurred.

Action B: Check the performance of your computer devices or network.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your service representative.

Cause: You selected a file for analysis that is still open in an editing window.

This is an information-only message and displays when you click No to 
message 6005. 

Action: Click OK to close the dialog. Then, either continue editing the file, save 
and close it; or click Browse and choose a different file for your anal-
ysis.
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6003- File (file name) cannot be opened. It is currently being setup for an analysis.

6004 An analysis cannot be performed on (file name). It is open for editing and contains 
errors.

6005- The edit session for (file name) must be saved before the analysis. Save changes 
and continue with the analysis?

6006- At least one report item must be selected. Press Cancel if you do not want a report.

Cause: You attempted to open a file that is currently being used in an analysis.

Action: Select a different file.

Cause: You attempted to start an analysis using a file that contains errors and is 
open for editing.

Action A: Finish editing the file, save, and close it, or choose a different file. Then 
restart the analysis.

Cause: You attempted to start an analysis using a file that contains unsaved 
changes and is still open.

Action: Click Yes to save the changes and proceed with the analysis.

Click No to cancel the analysis and (1) continue editing the file, save and 
close it; or (2) click Browse and choose a different file.

Cause: You failed to select reports in the Selected Reports list window. No out-
put could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit 
the sample for reporting, or click Cancel.
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6007- No data available in file (file name) for reporting.

6017- Lower piston motor failure.

6018- The lower piston cannot be moved because it is under load. Relieve the pressure 
on the lower piston and try again.

6019- The lower piston cannot be moved because the upper piston is too low. Raise the 
upper piston into the chamber and try again.

6020- The upper piston cannot be moved down with the lower piston in its current posi-
tion. The upper piston will only move down when the lower piston is either fully 
open or fully closed.

Cause: You requested a report for a file that does not contain collected data.

Action: Choose a file that contains collected data (Complete status).

Cause: The lower piston cannot drive to the requested position.

Action: Contact your service representative.

Cause: You attempted to move the lower piston but its load is too high.

Action: Raise the upper piston so that it is not pressing against the lower one.

Cause: The lower piston will not move because the upper piston tip is too low.

Action: Raise the upper piston above 0.025 inch to allow the lower piston to 
move.

Cause: You attempted to move the upper piston when the lower piston was not 
in the correct position.

Action: Open or close the lower piston completely. The lower piston must be 
fully open or completely closed for the piston to move.
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6021 The Zero Height calibration failed. Please check that the chamber is empty, and the 
piston tip is clean and undamaged and repeat the calibration.

6022- Analysis cancelled. The instrument zero height is out of specification. Please 
check that the sample tray is in place, the chamber is empty, and the piston tips 
are clean and undamaged.

Cause: The upper piston tip is damaged.

Action: Replace the upper piston tip, then repeat the calibration.

Cause: The upper piston tip contains sample or debris.

Action: Select Unit > Clean System to clean the system, then repeat the cali-
bration.

Cause A: The chamber was not empty for the blank analysis. 

Action A: Repeat the analysis starting with a clean, empty chamber. Do not load 
sample until prompted to do so.

Cause B: A piston tip is damaged or very dirty.

Action B: Clean or replace the piston tip.

Cause C: Your instrument may need servicing.

Action C: Contact your service representative.
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6023- The Height Scale calibration failed. Please check that the chamber contains only 
the calibration standard, that the length of the standard was entered correctly, and 
that the piston tips are clean and undamaged.

6024- Unable to drive upper piston. Check the condition and contents of the chamber, 
and that the instrument is enabled.

Cause A: The sample chamber contains sample or debris.

Action A: Select Unit > Clean System to clean the system; then load the calibra-
tion standard and repeat the calibration.

Cause B:  The length of the calibration standard was not entered correctly.

Action B: Enter the length stamped on the calibration standard.

Cause C: A piston tip is damaged or very dirty.

Action C: Clean or replace the piston tip.

Cause A: Debris is in the chamber.

Action A: Select Unit > Clean System to clean the system. The chamber should be 
empty for the blank analysis. Do not load the sample until prompted to 
do so.

Cause B: One of the safety interlocks was triggered.

Action B: Ensure that the safety shield for the sample compartment is completely 
down, and that the front drawer is completely closed. Then press the 
Reset button.

Turn the red Emergency Stop button clockwise to reset it, then press the 
Reset button.
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6025- Unable to reach the requested ending pressure.

6026- The instrument is currently disabled. Ensure that the shield is down and the 
drawer closed, and press the instrument reset button.

6027- Instrument fault.

6028- The sample file has an invalid status and cannot be used for analysis.

6029- Application restarted during an analysis. Analysis canceled.

Cause: The instrument could not build pressure to the endpoint specified in the 
Analysis Conditions dialog.

Action: Check that the ending pressure in the analysis conditions is within the 
specification for your instrument. If it is, then call your service repre-
sentative.

Cause: One of the safety interlocks was triggered.

Action A: Ensure that the safety shield for the sample compartment is completely 
down, and that the disposal drawer is completely closed. Then press the 
Reset button.

Action B: Turn the red Emergency Stop button clockwise to reset it, then press the 
Reset button.

Cause: You selected a sample file with a status other than No Analysis.

Action: Select a sample file that has not been used in an analysis.

Cause: You exited the application during an analysis and when you restarted the 
application, the analysis had been canceled.

Action: None required. The data collected up to the point of cancellation will be 
saved in the sample file.
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6030- Unable to read the calibration file (file name).

6031- Unable to write the calibration file (file name).

6032- File contains calibration data for a different unit (S/N: nnn).

6035- Analysis cancelled because there is not enough data for a blank correction. 
Decrease the Recording Interval, increase the Ending Pressure, and/or decrease 
the Scan Rate.

Cause: You selected an invalid calibration file or one that cannot be read.

Action: Be sure the media containing the calibration file has no problems.

Cause: An attempt to Save calibration data has failed due to possible media 
problems.

Action A: Confirm the media containing the calibration file has no problems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You loaded a calibration file that was created for a different unit.

Action A: Load a file that was created for the current unit.

Action B: Contact your service representative for assistance in calibration.

Cause: The combination of values you entered for the Scan Rate, Ending Pres-
sure, and Recording Interval does not yield enough data for a stable 
blank correction.

Action: Access the Analysis Conditions dialog and do one or more of the fol-
lowing:

• Decrease the Recording Interval
• Increase the Ending Pressure
• Decrease the Scan Rate
• Ensure that Use Prior Blank is not selected
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6036- Force calibration failed.

6037- Possible piston tip failure. Check that the chamber is empty and the tip is clean. If 
so, replace the piston tip.

Cause A: If this occurs during the Upper Force Scale calibration, the external ref-
erence load cell is not working properly.

Action A: Make sure the reference load cell has been tared properly and is dis-
playing the correct units. 

Cause B: If this occurs during the Lower Force Scale calibration, the upper load 
cell is calibrated properly.

Action B: Make sure the reference load cell has been tared properly and is dis-
playing the correct units. 

Cause C: Instrument failure.

Action C: Contact your service representative.

Cause A: Sample was in the chamber when the blank analysis was performed.

Action A: Select Unit > Clean System, then retry the analysis. Do not load sample 
until prompted to do so.

Cause B: The upper piston tip is dirty.

Action B: Thoroughly clean the upper piston tip with a Kimwipe and retry the 
analysis. 

Cause C: The upper piston tip has failed.

Action C: Replace the piston tip; refer to Replacing and Conditioning the Piston 
Tip, page 9-19.
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6039- Data Acquisition error.

6041- Not enough data collected in file (file name) for reporting.

6044- Use Prior Blank selected, but a prior blank could not be found.

6050- The lower piston did not successfully set the home position.

Cause A: Network activity is interfering with communication.

Action A: Close programs that use the network and disconnect and shared drives.

Cause B: You had other applications open while analysis data were being col-
lected.

Action B: Close all other applications when performing an analysis.

Cause C: A scheduled update was being performed while analysis data were being 
collected.

Action C:                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                Schedule automatic updates during a time when analyses are not being 
performed; for example, during non-working hours.

Cause D: The hardware configuration of the computer was changed during anal-
ysis.

Action D: Do not add or remove devices such as USB drives during analysis.

Cause: You requested a report for a file that does not contain collected data.

Action: Choose a file that contains collected data (Complete status).

Cause A: There was an obstruction in the lower piston path when the tray loading 
position was being set.

Action A: Open the tray drawer and repeat the sample tray.
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6051- Analysis cancelled. The difference between upper and lower load cell readings is 
too high. Check that the sample tray is in place.

6052- Analysis cancelled. The upper piston has reached the minimum allowed height. 
Check that the sample tray is in place.

Cause B: The lower piston drive assembly is damaged.

Action B: Contact your service representative.

Cause A: The sample tray containing the lower piston was not in place when the 
analysis was started.

Action A: Lower the lower piston, open the tray drawer, and install the sample tray.

Cause B: The upper or lower piston does not have a proper calibration.

Action B: Contact your service representative.

Cause A: The sample tray containing the lower piston was not in place when the 
analysis was started.

Action A: Lower the lower piston, open the tray drawer, and install the sample tray.

Cause B: The linear transducer does not have a proper calibration.

Action B: Contact your service representative.
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6053- The upper piston encountered an unexpected load. Check for obstructions and 
ensure that the upper piston tip is clean. If required, replace the upper piston tip..

6054- The line voltage (x% of nominal) is outside teh allowed range and may damage the 
instrument. Check that the line voltage selection switch is in the correct position 
and that the line voltage is adequate.

Cause A: The load on the upper piston is higher than expected for the given oper-
aiton.

Action A: Check for obstructions, and ensure that the upper piston tip is clean. If 
the error persists, replace and condition the upper piston tip.

Cause B: The upper piston is misaligned with the sample chamber.

Action B: Contact your service representative.

Cause: The measured line voltage is outside of the acceptable range.

Action: Ensure that the line voltage selection switch on the rear of the instrument 
is in the correct position. Ensure that the line voltage (as measured at the 
electrical receptacle) is with ±10% of the nominal value set by the line 
voltage selection switch.
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B.  CALCULATIONS

This appendix contains the calculations used in calibrations and in reports available in the DVVA 
II 4000 program.

Calibration

The force as a function of load cell voltage is found by a two-point linear calibration. One point 
(F1, V1) is measured with no applied force, so F1 = 0. The other (F2, V2) is measured with an 
applied force.

The piston height as a function of linear transducer voltage is also found by a two-point linear cal-
ibration. One point (h1, V1) is measured with an empty chamber, so h1 = 0. The other (h2, V2) is 
measured with a reference standard of known height (h2) in the sample chamber.

where

F = measured force
V = voltage
h = measured height

F F2 
V V1–

V2 V–
---------------

1
=

h h2 
V V1–

V2 V–
---------------

1
=
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Blank Correction

A blank analysis is performed to correct for the frictional force between the piston and the sample 
chamber, and for the deflection of the linear transducer.

where

F       =   applied force
FS = force on sample
Ff = frictional force
hb = bed height
h = measured height
hd = deflection

Void Volume

where

VA = apparent volume
Fs         =  force of sample
hb = bed height
m = mass
S = skeletal density
d = diameter of sample chamber

FS F Ff hb –=

hb h hd F –=

VV FS  VA FS  VT–  100=

VA FS  hbA=

A
d

2

4
---------=

VT
m
S
-----=
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Compaction Equations

General Terms

VT (sometimes V0) = Bulk or Initial Volume. (Mass)/(Bulk Density, ρβ).

VS = Volume of Solids, (Mass)/(skeletal density, ρs).

Vv = Volume of the voids = VT - VS.

Void Ratio = 

Porosity = 

Kawakita

The Kawakita is given by:

where

P = applied pressure
C = relative volume decrease, 

a, b = material characteristic constants derived from a linear fit of 

V0 = initial volume
V = volume at pressure P 

Bauer

The Bauer equation is given by:

e
VV

VS
------

VT VS–

VS
------------------

S


----- 1–=+=

n
VV

VT
------

VT VS–

VT
------------------ 1


S
-----–== =

P
C
---- 1

ab
------ P

a
---+=

V0 V–

V0

---------------
P
C
---- vs P

e e0
3P
a

------- 
  b  

– 
 exp=
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where

e = void ratio, 

e0 = void ratio at P=0
P = applied pressure
a = granulate hardness parameter with units of pressure
b = dimensionless stiffness parameter between 0.3 (spherical grains) and 0.1 (angular 

grains)
VV = volume of the voids
VS = volume of the solids

Cooper Eaton

The Cooper-Eaton equation is given by:

where

V0 = volume at P=0
V = volume at P
VS = volume of the solid sample
P = applied pressure
a1 a2 = material characteristic constants 
b1 b2 = material characteristic constants

The terms on the right-hand side of the equation relate to the processes of particle rearrangement 
and particle deformation. The constants b1 and b2 represent the pressures required to induce com-
paction due to those processes, while a1 and b2 indicate the relative magnitude of each process.

Modified Heckel

The Modified Heckel equation is given by:

where

P = applied pressure
D = relative density

Vv

VS
------

V0 V–

V0 VS–
------------------ a1 

b1

P
-----– 

  a2 exp
b2

P
-----– 

 +exp=

1
1 D–
------------- 
 ln aP

b
c+=
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a, b, and c =  material characteristic constants derived from a nonlinear fit of the equation. 

The pore fraction (1-D) is equal to the void ratio , which is the ratio of the volume of the

 voids Vv to the volume of the solid sample VS. Also called the porosity.

The Heckel* equation is the solution to a first order reaction, where the rate con-

stant, k, is equal to . The standard Heckel equation results from setting the exponent b 

to unity.

Wu

The Wu equation is given by:

where

e = void ratio 
e0 = void ratio at P=0
P = applied pressure
a, b = constants
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C.  BULK DENSITY FOR CARBON BLACK

Listed below are the bulk densities for the SRB series reference materials.

Series 8 (current)

Series 7 

Series 6 

Reference Name Bulk Density

A-8 Tread/Hard 0.41

B-8 Tread/Hard 0.31

C-8 Tread/Hard 0.29

D-8 Carcass/Soft 0.64

E-8 Carcass/Soft 0.44

F-8 Carcass/Soft 0.34

Reference Name Bulk Density

A-7 Tread/Hard 0.44

B-7 Tread/Hard 0.32

C-7 Tread/Hard 0.30

D-7 Carcass/Soft 0.65

E-7 Carcass/Soft 0.43

F-7 Carcass/Soft 0.31

Reference Name Bulk Density

A-6 Tread/Hard 0.31

B-6 Tread/Hard 0.34

C-6 Tread/Hard 0.46

D-6 Carcass/Soft 0.48

E-6 Carcass/Soft 0.44

F-6 Carcass/Soft 0.32
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INDEX

Symbols
$ symbol, 8-11

A
Active indicator, 2-1
Add Log Entry dialog, 5-6, 8-9
Advanced format, 5-4, 8-3

creating sample file, 3-6
sample defaults, 8-6
specifying sample defaults, 3-1

All file status, 2-11
Analysis

performing, 3-15, 6-3
reference, 6-7

Analysis Conditions dialog, 5-10
Analysis conditions file, 5-10

creating, 3-10
listing file statistics, 2-7, 3-24, 5-30
opening, 2-7
printing contents, 3-22, 5-28

Analysis dialog, 6-3
Analysis program

current version, 2-15
exiting, 2-7, 5-33
installing upgrade, 4-12
menu structure, 2-14
subsequent installation, 4-12
uninstalling, 4-19
using, 2-6

Analyzer
cleaning, 9-15
moving to a different computer, 4-14
operating in manual control mode, 6-10
physical dimensions, 1-4
removing from computer, 4-17
turning on and off, 2-5
weight and dimensions, 1-4

Analyzing file status, 2-11
Axis

coordinates, viewing, 7-23
properties, editing, 7-21

Axis Properties dialog, 7-21

B
Bar code reader, 3-2, 3-7, 5-5, 8-8
Basic format, 8-4

creating sample file, 3-8
sample file defaults, 8-10
Sample information file, 5-7
specifying defaults for, 3-1

Bauer report, 5-24
calculations, B-3

Bitmap graphic, in report header, 5-13
Blank analysis, 6-3
Blank correction calculations, B-2

C
Calculations, B-1

Bauer report, B-3
blank correction, B-2
Cooper-Eaton, B-4
Kawakita, B-3
Modified Heckel report, B-4
void volume, B-2

Calibration
calculations, B-1
date and time, 6-16
files, reinstalling, 4-18

Calibration command, 6-17
Cascade windows, 2-7, 2-15
Cautions, defined, 1-2
Check box, defined, 2-9
Circuit breakers, 2-3
Clean System command, 6-9
Clean System dialog, 6-9
Close Reports command, 7-4
Columns, editing on onscreen reports, 7-18
Comments window, 5-5
Complete file status, 2-11
Computer requirements, 1-5
Control Chart command, 7-9
Control Chart dialog, 7-9
Control Chart Graph Options dialog, 7-10
Control Chart report, 7-9

defining the Y-axis, 7-10
recalculating archived results, 7-11

Control Chart Sample Selection dialog, 7-11
Controls, Indicators, and Connectors

front panel, 2-1
rear panel, 2-3

Conventions, used in operator’s manual, 1-2
Cooper-Eaton

calculations, B-4
Cooper-Eaton report, 5-26
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Cross hair, axis, 7-23
Curve Properties dialog, 7-20

D
Data entry field, 2-8

viewing valid ranges, 2-9
Data, exporting, 3-26
Date Range push button, 2-10
Default Style dialog, 7-17
Defaults

file name extensions, 2-13
parameter files, 3-1
sample file sequence number, 8-7
sample files, 3-1

Defaults, sample
Advanced format, 3-1, 8-6
Basic format, 3-4, 8-10
for parameter files, 8-6
Restricted format, 3-4

Dialog boxes, using, 2-8
Directory

navigating to a different, 2-12
parameter files, 8-19

Drop-down list, defined, 2-9

E
Emergency Stop button, 2-1
Enable Manual Control command, 6-10
Enhanced metafile, in report header, 5-13
Error messages, A-1
Exit command, 5-33
Exiting the analysis program, 5-33
Export command, 5-32
Export Sample File dialog, 5-32
Export Settings dialog, 6-5
Exporting sample files, 5-32

F
Fault indicator, 2-1

troubleshooting, 9-1
File

opening, 2-7
printing to, 7-3
selecting, 2-10
status, 2-11

File menu, 5-1
Exit command, 5-33
Export command, 5-32
Open command, 5-2
Print command, 5-28

Save As command, 5-27
File name

default extensions, 2-13
included as part of ID, 8-7, 8-11
sequence, 8-11

Formula
for user models, 8-15

Front panel, 2-1
Function keys

See Shortcut keys

G
Graph

copying as metafile, 7-21
during data collection, 8-18
editing onscreen, 7-19
editing thickness, 7-17
grid lines, 8-18
legend, editing, 7-21
overlays, 3-27

Graph Grid Lines dialog, 8-18
Graph Overlay Samples dialog, 5-13
Graph report, 5-20
Graphic, in report title, 5-13
Grid lines, 8-18

H
Help menu, 2-15

I
Information bar, 2-9
Instrument log, 6-14
Instrument schematic, 6-10

component shortcut menu, 6-12
description of components on, 6-11
displaying, 6-12

K
Kawakita report, 5-23

calculations, B-3

L
Legend Properties dialog, 7-21
List command, 5-30
Live Graph command, 8-18
Log

See Instrument log
Log Report Settings dialog, 6-14
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M
Main Menu bar, 2-14
Maintenance, 9-15
Manual control

enabling, 6-10
selecting components, 6-10
shortcut menus, 6-12

Menu
bar, 2-14
shortcut, 2-6
structure, 2-14

Metafile, copying graphs as, 7-21
Model Table dialog, 8-1, 8-14
Model Table Edit dialog, 8-14
Models

formula, 8-14
load from file, 8-17
save to file, 8-17
user-defined, 5-5, 6-5, 8-9, 8-14

Modified Heckel report, 5-22
calculations, B-4

N
No Analysis file status, 2-11
Normalization, 6-19

procedure, 9-27
Normalization command, 6-19
Notes, defined, 1-2

O
Online manual

accessing, 2-7
Onscreen report, 7-14

editing, 7-18
saving, 7-17
shortcut menus, 7-18
See also  Report

Open command, 5-2
Open Report command, 7-4
Operator, specifying, 8-8
Operator’s manual

conventions, 1-2
organization, 1-1

Option Presentation command, 8-3
Options menu, 8-1

Graph Grid Lines command, 8-18
Live Graph command, 8-18
Option presentation command, 8-3
Parameter Files Directory command, 8-19
Reference Table command, 8-13
Sample Defaults command, 8-6

Service Test Mode, 8-19
Units command, 8-17

Ordering information, 10-1
Overlay

Graph overlay, 3-27
multiple graphs, 3-29
multiple samples, 3-27

Overlays push button, 5-13

P
Parameter files, 3-9, 5-3

Analysis conditions, creating, 3-10
creating, 5-2
defaults, 8-6
directory, 8-19
listing file statistics, 3-24
printing contents of, 3-22
Report options, creating, 3-11
specifying defaults, 3-1
specifying location, 8-19

Parameter Files Directory command, 8-19
Parameters, user, 8-9
Password

Restricted format, 8-5
service tests, 8-19

Piston
count for current, 6-16
manual control, 6-11
release procedure, lower piston, 9-8
returning to home position, 6-8
speed, 6-12
tip, replacing, 9-27
troubleshooting, 9-3

Piston tip, 6-7
cleaning, 9-20
conditioning, 9-19
replacing, 6-7, 9-16

Pop-up menu
See Menu

Pour density, 5-5, 5-8
Power

full power-off procedure, 9-5
full power-on procedure, 9-4
troubleshooting, 9-6

Presentation options, 8-3
Pressure Table report, 5-19
Print command, 5-28
Push button

defined, 2-8
Overlays, 5-13
Replace All, 5-7
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R
Radio button, defined, 2-9
Ranges, viewing for selected field, 2-9
Ready indicator, 2-1
Rear panel, 2-3
Reference

material, default numbers, 8-13
Reference Defaults dialog, 8-1, 8-13
Reference Run command, 6-7
Reference Run dialog, 6-7
Reference Table command, 8-13
Reference Table Edit dialog, 8-13
Regression report, 7-6

recalculating SPC values, 7-7
selecting X- and Y-Axes variables, 7-6

Regression Report command, 7-6
Regression Report dialog, 7-6
Regression Report Sample Selection dialog, 7-7
Removing an analyzer, 4-17
Replace All push button, 5-6
Report

Bauer, 5-24
calculations, B-1
closing, 7-4
closing all, 2-7
Control Chart, 7-9
Cooper-Eaton, 5-26
deleting from onscreen report, 7-15
displaying company logo in title, 5-13
editing font, curve thickness, and graph border, 7-17
exporting automatically, 3-16
exporting automatically after analysis, 6-5
generating, 7-2
generating automatically, 3-16
generating automatically after analysis, 6-5
graphs, editing onscreen, 7-19
header, 7-13
hiding from onscreen report, 7-15
Kawakita, 5-23
legend, editing, 7-21
Modified Heckel, 5-22
onscreen, 7-14
opening, 7-4
Pressure Table, 5-19
Regression, 7-6
Sample Log, 5-21
saving, 7-16
saving in other formats, 7-17
selecting, 2-12
Standard table, 5-18
starting, 2-7
Statistical Process Control (SPC), 7-5
Summary, 5-15

Tabular, editing onscreen, 7-18
title, showing, 5-12
Tool bar, 7-15
Uncorrected Data, 5-21
Wu, 5-25
zoom feature, 7-22

Report button, 7-8
Report Options dialog, 5-12
Report options file, 5-12

creating, 3-11
listing file statistics, 2-7, 3-24, 5-30
opening, 2-7
printing contents, 3-22, 5-28

Reports menu, 7-1
Close Reports command, 7-4
Control Chart command, 7-9
Open report command, 7-4
Regression Report command, 7-6
SPC Report Options command, 7-5
Start Report command, 7-2

Reports Setting dialog, 6-5
Reset button, 2-2
Restricted format, 8-5

creating sample file, 3-8
default values, 3-4
Sample information file, 5-9
specifying defaults, 8-10

Return Lower Piston Home command, 6-8
Return Upper Piston Home command, 6-8

S
Safety, 2-5

shield, 2-4
Sample

information, defining, 3-6
preparing, 3-13
properties, 5-8

Sample Analysis command, 6-3
Sample compartment shield, 2-4
Sample defaults

Advanced format, 8-6
Basic format, 8-10
Restricted format, 8-10
specifying, 8-6

Sample Defaults command, 8-6
Sample information dialog

Advanced format, 5-4
Basic format, 5-7, 5-9

Sample information file, 5-3
Advanced format, 3-6, 5-4
Basic format, 3-8, 5-7
creating, 3-6, 5-2
Default values, 3-1
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defaults for Advanced format, 8-6
exporting data, 3-26
listing file statistics, 2-7, 3-24, 5-30
name, specifying default sequence, 8-7
opening, 2-7
printing contents, 3-22, 5-28
Restricted format, 3-8, 5-9
selecting, 2-10
specifying defaults, 3-1, 8-6
specifying defaults for Advanced format, 3-1
specifying defaults for Basic format, 3-4
status types, 2-11

Sample Log report, 5-21
Sample shield

cleaning, 9-15
Save As command, 5-27
Save as Default push button, 7-12
Schematic

See Instrument Schematic
Select Dates dialog, 2-10
Select User Model File dialog, 8-17
Sequence number, specifying, 8-7
Service Test Mode command, 8-19
Set Lower Piston Home dialog, 6-17
Setup program, 4-10

moving an analyzer to a different computer, 4-14
reinstalling analysis program, 4-12
reinstalling calibration files, 4-18
removing an analyzer from the computer, 4-17
uninstalling the software, 4-19

Shortcut keys, 2-6
for Select Dates dialog, 2-11
list of, 2-7

Shortcut menu, 2-6
accessing, 2-7
for graphs, 7-19
for tabular reports, 7-18
instrument schematic, 6-12

Show Instrument Log command, 6-14
Show Instrument Schematic command, 6-12
Show Status command, 6-13
Skeletal density, 5-5
Software

Analysis program, 4-1
installing upgrade, 4-12
uninstalling, 4-19
using, 2-6
using for offline data reduction, 4-1
version, 2-15, 6-16

SPC report
user parameters, 5-5, 6-5, 8-9

SPC Report Options command, 7-5
SPC Report Options dialog, 7-5
Specifications, 1-4, 1-5

Spreadsheet format
saving reports, 7-17

Standard Table report, 5-18
Start Report command, 7-2
Start Report dialog, 7-2
Status drop-down list, 2-11
Status types, list of, 2-11
Status window, showing, 6-13
Submitter, specifying, 8-8
Summary Report, 8-14
Summary report, 5-15
Summary Report dialog, 5-15
System, cleaning, 6-9

T
Text, copy graph data as, 7-21
Tile windows, 2-7, 2-15
Title Properties dialog, 7-21
Tool bar, reports window, 7-15
Trend plot, 5-20
Troubleshooting, 9-1
True density, 5-5

U
Uncorrected Data Report, 5-21
Unit Configuration command, 6-16
Unit Configuration dialog, 6-16
Unit configuration, displaying, 6-16
Unit menu, 6-1

Calibration command, 6-17
Clean System command, 6-9
Enable Manual Control command, 6-10
Normalization command, 6-19
Reference Run command, 6-7
Return Lower Piston Home command, 6-8
Return Upper Piston Home command, 6-8
Sample Analysis command, 6-3
Show Instrument Log command, 6-14
Show Instrument Schematic command, 6-12
Show Status command, 6-13
Unit Configuration command, 6-16

Units command, 8-17
Units Selections dialog, 8-17
Use prior blank, 5-11
User interface, 2-1
User models

See Models, user-defined
User parameters, 5-5

specifying, 8-9
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V
Version, software, 2-15, 6-16
View drop-down list, 6-3
Void volume, 5-11, 8-13

calculations, B-2
Voltage selector, 2-3

W
Warning

defined, 1-2
label, 2-5

Windows menu, 2-15
Wu report, 5-25

calculations, B-5

X
X-axis order by, 7-9

Z
Zoom feature, 7-22


